
2Formulas, Functions, 
Formatting, and Web 
Queries

• Enter formulas using the keyboard 
and Point mode

• Apply the AVERAGE, MAX, and MIN 
functions

• Verify a formula using Range Finder

• Apply a theme to a workbook

• Add conditional formatting to cells

• Change column width and row 
height

• Check the spelling of a worksheet

• Set margins, headers and footers in 
Page Layout View

• Preview and print versions of a 
worksheet

• Use a Web query to get real-time 
data from a Web site

• Rename sheets in a workbook

• E-mail the active workbook from 
within Excel

Objectives
You will have mastered the material in this chapter when you can:

Microsoft Offi ce Excel 2007
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Introduction
In Chapter 1, you learned how to enter data, sum values, format the worksheet to make it 
easier to read, and draw a chart. You also learned about using Help and saving, printing, 
and opening a workbook. This chapter continues to highlight these topics and presents 
some new ones.

The new topics covered in this chapter include using formulas and functions to 
create a worksheet. A function is a prewritten formula that is built into Excel. Other new 
topics include smart tags and option buttons, verifying formulas, applying a theme to a 
worksheet, adding borders, formatting numbers and text, using conditional formatting, 
changing the widths of columns and heights of rows, spell checking, e-mailing from within 
an application, renaming worksheets, using alternative types of worksheet displays and 
printouts, and adding page headers and footers to a worksheet. One alternative worksheet 
display and printout shows the formulas in the worksheet, instead of the values. When 
you display the formulas in the worksheet, you see exactly what text, data, formulas, and 
functions you have entered into it. Finally, this chapter covers Web queries to obtain 
real-time data from a Web site.

Project — Worksheet with Formulas, Functions, 
and Web Queries
The project in the chapter follows proper design guidelines and uses Excel to create the 
two worksheets shown in Figure 2–1. The Silver Dollars Stock Club was started and is 
owned by a national academic fraternity, which pools contributions from a number of 
local chapters. Each local chapter contributes $150 per month; the money is then invested 
in the stock market for the benefi t of the organization and as a tool to help members learn 
about investing. At the end of each month, the club’s treasurer summarizes the club’s 
fi nancial status in a portfolio summary. This summary includes information such as the 
stocks owned by the club, the cost of the stocks to the club, and the gain or loss that the 
club has seen over time on the stock. As the complexity of the task of creating the sum-
mary increases, the treasurer wants to use Excel to create the monthly portfolio summary. 
The treasurer also sees an opportunity to use Excel’s built-in capability to access real-time 
stock quotes over the Internet. 

Recall that the fi rst step in creating an effective worksheet is to make sure you 
understand what is required. The people who will use the worksheet usually provide 
requirements. The requirements document for the Silver Dollars Stock Club Portfolio 
Summary worksheet includes the following: needs, source of data, summary of calcula-
tions, Web requirements, and other facts about its development (Figure 2–2 on page 
EX 84). The real-time stock quotes (shown in Figure 2–1b) will be accessed via a Web 
query. The stock quotes will be returned to the active workbook on a separate worksheet. 
Microsoft determines the content and format of the Real-Time Stock Quotes worksheet.

2 Formulas, Functions, Formatting, 
and Web Queries

EX 82

Microsoft Offi ce Excel 2007
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EX 83

Microsoft Offi ce Excel 2007  

worksheet with 
formulas and 
functions

(a) 
Worksheet

(b) 
Web Query

Figure 2–1

worksheet 
automatically created 
by Web query includes 
real-time stock quotes
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Overview
As you read this chapter, you will learn how to create the worksheet shown in 

Figure 2–1 by performing these general tasks:
• Enter formulas and apply functions in the worksheet
• Add conditional formatting to the worksheet
• Apply a theme to the worksheet
• Work with the worksheet in Page Layout View
• Print a part of the worksheet
• Perform a Web query to get real-time data from a Web site and create a new 

worksheet
• E-mail the worksheet

Figure 2–2

Aesthetics versus 
Function
In designing a worksheet, 
functional considerations 
should come fi rst, before 
visual aesthetics. The 
function, or purpose, of a 
worksheet is to provide a 
user with direct ways to 
accomplish tasks. Avoid 
the temptation to use 
fl ashy or confusing visual 
elements within the 
worksheet, unless they 
will help the user more 
easily complete a task. 
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Project—Worksheet with Formulas, Functions, and Web Queries   EX 85

General Project Decisions
While creating an Excel worksheet, you need to make several decisions that will determine 
the appearance and characteristics of the fi nished worksheet. As you create the worksheet 
required to meet the requirements shown in Figure 2–2, you should follow these general 
guidelines:

1. Plan the layout of the worksheet. As discussed in Chapter 1 and shown in Figure 2–3, 
rows typically contain items analogous to items in a list. In the case of the stock club’s 
data, the individual stocks serve this purpose and each stock should be placed in a row. As 
the club adds more stocks, the number of rows in the worksheet will increase. Information 
about each stock and associated calculations should appear in columns. 

2. Determine the necessary formulas and functions needed. Values such as initial cost and 
current value are calculated from known values. The formulas for these calculations 
should be known in advance of creating the worksheet. Values such as the average, high-
est, and lowest values can be calculated using Excel functions as opposed to relying on 
complex formulas.

3. Identify how to format various elements of the worksheet. As discussed in Chapter 1 and 
shown in Figure 2–3, the appearance of the worksheet affects its ability to communicate 
clearly. Numeric data should be formatted in generally accepted formats, such as using 
commas as thousands separators and parentheses for negative values.

4. Establish rules for conditional formatting. Conditional formatting allows you to format a 
cell based on the contents of the cell. Decide under which circumstances you would like 
a cell to stand out from similar cells and determine in what way the cell will stand out. In 
the case of the Percent Gain/Loss column on the worksheet, placing a different background 
color in cells that show losses is an appropriate format for the column.

5. Specify how the printed worksheet should appear. When it is possible that a person will 
want to print a worksheet, care should be taken in the development of the worksheet to 
ensure that the contents can be printed in a readable manner. Excel prints worksheets in 
landscape or portrait orientation and margins can be adjusted to fi t more or less data on 
each page. Headers and footers add an additional level of customization to the printed page.

(continued)

Plan 
Ahead

Figure 2–3 

Xs indicate 
text data

$ adjacent to Z 
indicates fl oating 
dollar sign

$ not adjacent to 
Z indicates a fi xed 
dollar sign

Zs indicate 
numeric data with 
0s suppressed

9s indicate 
numeric data 
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EX 86   Excel Chapter 2   Formulas, Functions, Formatting, and Web Queries

(continued)

6. Gather information regarding the needed Web query. You must also know what information 
the Web query requires in order for it to generate results that you can use in Excel.

7. Choose names for the worksheets. When a workbook includes multiple worksheets, 
each worksheet should be named. A good worksheet name is succinct, unique to the 
workbook, and meaningful to any user of the workbook.

In addition, using a sketch of the worksheet can help you visualize its design. The sketch 
for Silver Dollars Stock Club Portfolio Summary worksheet (Figure 2–3 on the previous page) 
includes a title, a subtitle, column and row headings, and the location of data values. It also 
uses specifi c characters to defi ne the desired formatting for the worksheet as follows:

1. The row of Xs below the leftmost column defi nes the cell entries as text, such as stock 
names and stock symbols.

2. The rows of Zs and 9s with slashes, dollar signs, decimal points, commas, and percent 
signs in the remaining columns defi ne the cell entries as numbers. The Zs indicate that 
the selected format should instruct Excel to suppress leading 0s. The 9s indicate that the 
selected format should instruct Excel to display any digits, including 0s. 

3. The decimal point means that a decimal point should appear in the cell entry and indicates 
the number of decimal places to use.

4. The commas indicate that the selected format should instruct Excel to display a comma 
separator only if the number has enough digits to the left of the decimal point.

5. The slashes in the third column identify the cell entry as a date.

6. The dollar signs that are not adjacent to the Zs in the fi rst row below the column head-
ings and in the total row signify a fi xed dollar sign. The dollar signs that are adjacent to 
the Zs below the total row signify a fl oating dollar sign, or one that appears next to the 
fi rst signifi cant digit.

7. The percent sign (%) in the far right column indicates a percent sign should appear 
after the number.

When necessary, more specifi c details concerning the above guidelines are presented 
at appropriate points in the chapter. The chapter also will identify the actions you per-
form and decisions made regarding these guidelines during the creation of the worksheet 
shown in Figure 2–3 on page EX 83.

Plan 
Ahead

With a good understanding of the requirements document, an understanding of the 
necessary decisions, and a sketch of the worksheet, the next step is to use Excel to create 
the worksheet.

To Start Excel

If you are using a computer to step through the project in this chapter and you want 
your screen to match the fi gures in this book, you should change your computer’s resolu-
tion to 1024 � 768. For information about how to change a computer’s resolution, read 
Appendix E.
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Entering the Titles and Numbers into the Worksheet   EX 87

The following steps, which assume Windows is running, start Excel based on a 
typical installation of Microsoft Offi ce on your computer. You may need to ask your 
instructor how to start Excel for your computer.

1  Click the Start button on the Windows taskbar to display the Start menu.

2  Point to All Programs on the Start menu and then point to Microsoft Offi ce 2007 in the All 
Programs submenu.

3  Click Microsoft Offi ce Excel 2007 on the Microsoft Offi ce 2007 submenu.

4  If the Excel window is not maximized, click the Maximize button next to the Close button 
on its title bar to maximize the window.

5  If the worksheet window in Excel is not maximized, click the Maximize button next to the  
Close button on its title bar to maximize the worksheet window within Excel.

Entering the Titles and Numbers into the 
Worksheet
The fi rst step in creating the worksheet is to enter the titles and numbers into the worksheet. 

To Enter the Worksheet Title and Subtitle

The following steps enter the worksheet title and subtitle into cells A1 and A2.

1  Select cell A1. Type Silver Dollars Stock Club in the cell and then press the DOWN 
ARROW key to enter the worksheet title in cell A1.

2  Type Portfolio Summary in cell A2 and then press the down arrow key to enter the 
worksheet subtitle in cell A2 (Figure 2–4 on page EX 90).

To Enter the Column Titles

The column titles in row 3 begin in cell A3 and extend through cell J3. The 
column titles in Figure 2–3 include multiple lines of text. To start a new line in a cell, 
press ALT+ENTER after each line, except for the last line, which is completed by clicking 
the Enter box, pressing the ENTER key, or pressing one of the arrow keys. When you 
see ALT+ENTER in a step, press the ENTER key while holding down the ALT key and then 
release both keys.

The stock names and the row titles Totals, Average, Highest, and Lowest in the 
leftmost column begin in cell A4 and continue down to cell A16. This data is entered 
into rows 4 through 12 of the worksheet. The remainder of this section explains the steps 
required to enter the column titles, stock data, and row titles as shown in Figure 2–4 on 
page EX 90 and then save the workbook.
1  With cell A3 selected, type Stock and then press the right arrow key.

2  Type Symbol in cell B3 and then press the right arrow key.

Starting Excel
You can use a 
command-line switch to 
start Excel and control 
how it starts. First, click 
the Start button on the 
Windows taskbar, and 
then click Run. Next, 
enter the complete path 
to Excel’s application fi le 
including the switch (for 
example, “C:\Program 
Files\Microsoft Offi ce\
Offi ce12\Excel.exe” 
/e). The switch /e starts 
Excel without opening a 
new workbook; /i starts 
Excel with a maximized 
window; /p “folder” sets 
the active path to folder 
and ignores the default 
folder; /r “fi lename” 
opens fi lename in read-
only mode; and /s starts 
Excel in safe mode.

B
T
W
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EX 88   Excel Chapter 2   Formulas, Functions, Formatting, and Web Queries

3  In cell C3, type Date and then press alt+enter. Type Acquired and then press the right 
arrow key.

4  In cell D3, type Shares and then press the right arrow key.

5  In cell E3, type Initial and then press alt+enter. Type Price and then press alt+enter. 
Type Per Share and then press the right arrow key.

6  Type Initial in cell F3 and then press alt+enter. Type Cost and then press the RIGHT 
ARROW key.

7  In cell G3, type Current and then press alt+enter. Type Price and then press alt+enter. 
Type Per Share and then press the right arrow key.

8  Type Current in cell H3 and then press alt+enter. Type Value and then press the RIGHT 
ARROW key.

9  In cell I3, type Gain/Loss and then press the right arrow key.

10  In cell J3, type Percent and then press alt+enter. Type Gain/Loss.

To Enter the Portfolio Summary Data

The portfolio summary data in Table 2–1 includes a purchase date for each stock. 
Excel considers a date to be a number and, therefore, it displays the date right-aligned in 
the cell. The following steps enter the portfolio summary data shown in Table 2–1.

1  Select cell A4, type Apple Computers, and then press the RIGHT ARROW key. 

2  Type AAPL in cell B4 and then press the right arrow key.

3  Type 12/1/04 in cell C4 and then press the right arrow key.

4  Type 440 in cell D4 and then press the right arrow key. 

5  Type 64.59 in cell E4 and then click cell G4.

6  Type 82.99 in cell G4 and then click cell A5.

7  Enter the portfolio summary data in Table 2–1 for the eight remaining stocks in rows 5 
through 12 (Figure 2–4).

To Enter the Row Titles

1  Select cell A13. Type Totals and then press the down arrow key. Type Average in 
cell A14 and then press the down arrow key.

2  Type Highest in cell A15 and then press the down arrow key. Type Lowest in cell A16 
and then press the enter key. Select cell F4.

Wrapping Text 
If you have a long 
text entry, such as a 
paragraph, you can 
instruct Excel to wrap the 
text in a cell, rather than 
pressing ALT+ENTER to 
end a line. To wrap text, 
right-click in the cell, 
click Format Cells on the 
shortcut menu, click the 
Alignment tab, and then 
click Wrap text. Excel 
will increase the height 
of the cell automatically 
so the additional lines 
will fi t. If you want to 
control where each line 
ends in the cell, rather 
than letting Excel wrap 
based on the cell width, 
however, then you 
must end each line with 
ALT+ENTER. 

B
T
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Two-Digit Years 
When you enter a 
two-digit year value, 
Excel changes a two-
digit year less than 30 
to 20xx and a two-digit 
year of 30 and greater 
to 19xx. Use four-digit 
years to ensure that Excel 
interprets year values 
the way you intend, if 
necessary.

B
T
W

Formatting a 
Worksheet 
With early worksheet 
programs, users often 
skipped rows to improve 
the appearance of the 
worksheet. With Excel it 
is not necessary to skip 
rows because you can 
increase row heights to 
add white space between 
information.

B
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W
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Entering the Titles and Numbers into the Worksheet   EX 89

Table 2–1 Silver Dollars Stock Club Portfolio Summary Data

Stock Symbol Date
Acquired

Shares Initial Price 
Per Share

Current 
Price Per 
Share

Apple Computers AAPL 12/1/04 440 64.59 82.99

AT&T T 12/16/03 870 28.71 27.99

Citigroup C 1/17/04 960 49.46 44.675

Comcast CMCSA 2/11/02 380 33.62 41.39

Google GOOG 2/20/04 920 390.32 492.55

Home Depot HD 11/14/05 770 34.54 31.72

IBM IBM 9/14/04 990 74.08 81.47

Merck MRK 1/14/05 950 42.125 38.34

Sprint Nextel S 9/10/03 560 17.79 21.18

Figure 2–4

worksheet title 
and subtitle

column titles on 
multiple lines 
within cell

dates entered with two-
digit year are displayed 
with four-digit year 
automatically

numbers

height of row 3 
automatically 
increased to fi t 
multiple lines of text
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Entering Formulas
One of the reasons Excel is such a valuable tool is that you can assign a formula to a cell 
and Excel will calculate the result. Consider, for example, what would happen if you had 
to multiply 440 � 64.59 and then manually enter the product, 28,419.60, in cell F4. Every 
time the values in cells D4 or E4 changed, you would have to recalculate the product and 
enter the new value in cell F4. By contrast, if you enter a formula in cell F4 to multiply 
the values in cells D4 and E4, Excel recalculates the product whenever new values are 
entered into those cells and displays the result in cell F4. 

Determine the necessary formulas and functions needed.
The formulas needed in the worksheet are noted in the requirements document as follows:

1. Initial Cost (column F) = Shares � Initial Price Per Share

2. Current Value (column H) = Shares � Current Price Per Share

3. Gain/Loss (column I) = Current Value – Initial Cost

4. Percent Gain/Loss (column J) = Gain/Loss  /  Initial Cost 

The necessary functions to determine the average, highest, and lowest numbers are 
discussed shortly.

Plan 
Ahead

To Change Workbook Properties and Save the Workbook

With the data entered into the worksheet, the following steps save the workbook 
using the fi le name, Silver Dollars Stock Club Portfolio Summary. As you are building a 
workbook, it is a good idea to save it often so that you do not lose your work if the com-
puter is turned off or if you lose electrical power. The fi rst time you save a workbook, you 
should change the workbook properties.

1  Click the Offi ce Button, click Prepare on the Offi ce Button menu, and then click Properties.

2  Update the document properties with your name and any other information required.

3  Click the Close button on the Properties pane. 

4  With a USB fl ash drive connected to one of the computer’s USB ports, click the Save button 
on the Quick Access toolbar.

5  When Excel displays the Save As dialog box, type Silver Dollars Stock Club 
Portfolio Summary in the File name text box.

6  If necessary, click UDISK 2.0 (E:) in the Save in list (your USB fl ash drive may have a 
different name and letter). Click the Save button in the Save As dialog box to save the 
workbook on the USB fl ash drive using the fi le name, Silver Dollars Stock Club Portfolio 
Summary.

Automatic 
Recalculation 
Every time you enter 
a value into a cell in 
the worksheet, Excel 
automatically recalculates 
all formulas. You can 
change to manual 
recalculation by clicking 
the Calculation Options 
button on the Formulas 
tab on the Ribbon and 
then clicking Manual. 
In manual calculation 
mode, press the F9 key 
to instruct Excel to 
recalculate all formulas.

B
T
W

Entering Numbers 
in a Range
An effi cient way to enter 
data into a range of 
cells is to select a range 
and then enter the fi rst 
number in the upper-left 
cell of the range. Excel 
responds by entering the 
value and moving the 
active cell selection down 
one cell. When you enter 
the last value in the fi rst 
column, Excel moves the 
active cell selection to the 
top of the next column.

B
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Entering Formulas   EX 91

To Enter a Formula Using the Keyboard

The initial cost for each stock, which appears in column F, is equal to the number of shares in column D times 
the initial price per share in column E. Thus, the initial cost for Apple Computers in cell F4 is obtained by multiplying 
440 (cell D4) by 64.59 (cell E4) or =D4*E4. The following steps enter the initial cost formula in cell F4 using the 
keyboard.

1
• With cell F4 selected, type =d4*e4 

in the cell to display the formula 
in the formula bar and in cell F4 
and to display colored borders 
around the cells referenced in the 
formula (Figure 2–5).

What is happening on the worksheet 
as I enter the formula? 

The equal sign (=) preceding 
d4*e4 is an important part of the 
formula. It alerts Excel that you 
are entering a formula or function 
and not text. Because the most 
common error when entering a 
formula is to reference the wrong 
cell in a formula mistakenly, Excel 
colors the borders of the cells ref-
erenced in the formula. The color-
ing helps in the reviewing process 
to ensure the cell references are 
correct. The asterisk (*) follow-
ing d4 is the arithmetic operator 
that directs Excel to perform the 
multiplication operation.

Figure 2–5

formula begins 
with equal sign 

colored cell borders 
indicate cells 
included in formula 
in active cell 

as formula is typed, it 
appears in the formula 
bar and in active cell F4

Q
&

A

2
• Press the RIGHT ARROW key twice to 

complete the arithmetic operation 
indicated by the formula, display 
the result, 28419.6, and to select 
cell H4 (Figure 2–6).

Figure 2–6

value of formula 
(440 x 64.59)

active cell is H4 
after pressing RIGHT 
ARROW key twice
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Arithmetic Operations
Table 2–2 describes multiplication and other valid Excel arithmetic operators.

Table 2–2 Summary of Arithmetic Operators 

Arithmetic 
Operator

Meaning
 Example of 

Usage
Meaning

– Negation –34 Negative 34

% Percentage =72% Multiplies 72 by 0.01

^ Exponentiation =4 ^ 6 Raises 4 to the sixth power 

* Multiplication =22.6 * F4 Multiplies the contents of cell F4 by 22.6

/ Division =C3 / C6 Divides the contents of cell C3 by the contents of cell C6

+ Addition =7 + 3 Adds 7 and 3

– Subtraction =F12 – 22 Subtracts 22 from the contents of cell F12

You can enter the cell references in formulas in uppercase or lowercase, and you can 
add spaces before and after arithmetic operators to make the formulas easier to read. The 
formula, =d4*e4, is the same as the formulas, =d4 * e4, =D4 * e4, or =D4 * E4.

Order of Operations
When more than one arithmetic operator is involved in a formula, Excel follows 

the same basic order of operations that you use in algebra. Moving from left to right in a 
formula, the order of operations is as follows: fi rst negation (–), then all percentages (%), 
then all exponentiations (^), then all multiplications (*) and divisions (/), and fi nally, all 
additions (+) and subtractions (–).

You can use parentheses to override the order of operations. For example, if Excel 
follows the order of operations, 5 * 9 + 8 equals 53. If you use parentheses, however, to 
change the formula to 5 * (9 + 8), the result is 85, because the parentheses instruct Excel 
to add 9 and 8 before multiplying by 5. Table 2–3 illustrates several examples of valid 
Excel formulas and explains the order of operations.

Table 2–3 Examples of Excel Formulas 

Formula Meaning

=K12 Assigns the value in cell K12 to the active cell.

=10 +  4^2 Assigns the sum of 10 + 16 (or 26) to the active cell.

=3 * C20 or =C20 * 3 or =(3 * C20) Assigns three times the contents of cell C20 to the active cell. 

=50% * 12 Assigns the product of 0.50 times 12 (or 6) to the active cell.

– (H3 * Q30) Assigns the negative value of the product of the values contained in cells H3 and Q30 to the active cell.

=12 * (N8 – O8) Assigns the product of 12 times the difference between the values contained in cells N8 and O8 to the 
active cell.

=M9 / Z8 – C3 * Q19 + A3 ^ B3 Completes the following operations, from left to right: exponentiation (A3 ^ B3), then division (M9 / Z8), 
then multiplication (C3 * Q19), then subtraction (M9 / Z8) – (C3 * Q19), and fi nally addition (M9 / Z8 
– C3 * Q19) + (A3 ^ B3). If cells A3 = 2, B3 = 4, C3 = 6, M9 = 3, Q19 = 4, and Z8 = 3, then Excel assigns 
the active cell the value 18; that is, 3 / 3 – 6 * 4 + 2 ^ 4 = -7.

Troubling Formulas 
If Excel does not accept 
a formula, remove the 
equal sign from the 
left side and complete 
the entry as text. Later, 
after you have entered 
additional data or 
determined the error, 
reinsert the equal sign to 
change the text back to 
a formula and edit the 
formula as needed.

B
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To Enter Formulas Using Point Mode

The sketch of the worksheet in Figure 2–3 on page EX 85 calls for the current value, gain/loss, and percent 
gain/loss of each stock to appear in columns H, I, and J respectively. All three of these values are calculated using 
formulas in row 4:  

Current Value (cell H4) = Shares � Current Price Per Share or =D4*G4
Gain/Loss (cell I4) = Current Value – Initial Cost or H4-F4
Percent Gain/Loss (cell J4) = Gain/Loss  /  Initial Cost or I4/F4

An alternative to entering the formulas in cells H4, I4, and J4 using the keyboard is to enter the formulas 
using the mouse and Point mode. Point mode allows you to select cells for use in a formula by using the mouse. The 
following steps enter formulas using Point mode.

1
• With cell H4 selected, type = (equal 

sign) to begin the formula and 
then click cell D4 to add a 
reference to cell D4 to the formula 
(Figure 2–7).

Figure 2–7

cell reference D4 
appended to formula

marquee surrounds 
selected cell D4

2
• Type * (asterisk) and then click 

cell G4 to add a multiplication 
operator and reference to cell G4 
to the formula (Figure 2–8).

Figure 2–8

formula appears 
in formula bar

cell reference G4 
appended to formula

marquee surrounds 
selected cell G4

border of cell and 
its cell reference 
in formulas are 
colored blue
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Figure 2–9

formula appears 
in formula bar

Enter box
value of formula 
(440 x 82.99)

cell reference 
F4 appended 
to formula

marquee 
surrounds 
selected cell F4

Q
&
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3
• Click the Enter box and then click 

cell I4 to select cell I4.

• Type = (equal sign) and then click 
cell H4 to add a reference to cell 
H4 to the formula.

• Type — (minus sign) and then 
click cell F4 to add a subtraction 
operator and reference to cell F4 
to the formula (Figure 2–9).

When should I use Point mode to 
enter formulas? 

Using Point mode to enter 
formulas often is faster and more 
accurate than using the keyboard 
to type the entire formula when 
the cell you want to select does 
not require you to scroll. In many 
instances, as in these steps, you may want to use both the keyboard and mouse when entering 
a formula in a cell. You can use the keyboard to begin the formula, for example, and then 
use the mouse to select a range of cells.

4

• Click the Enter box to enter the 
formula in cell I4.

• Select cell J4. Type = (equal sign) 
and then click cell I4 to add a 
reference to cell I4 to the formula.

• Type / (forward slash) and then 
click cell F4 to add a reference to 
cell F4 to the formula.

• Click the Enter box to enter the 
formula in cell J4 (Figure 2–10).

Why do only six decimal places 
show in cell J4? 

The actual value assigned by Excel 
to cell J4 from the division op-
eration in Step 4 is 0.284873819. 
While not all the decimal places 
appear in Figure 2–10, Excel maintains 
all of them for computational purposes. Thus, if referencing cell J4 in a formula, the value 
used for computational purposes is 0.284873819, not 0.284874. Excel displays the value in 
cell J4 as 0.284874 because the cell formatting is set to display only six digits after the deci-
mal point. If you change the cell formatting of column J to display 15 digits after the decimal 
point, then Excel displays the true value 0.284873819.

Q
&

A

Figure 2–10

value of formula 
(36515.6 – 28419.6)

formula 
assigned to 
cell J4 value of formula 

(8096 / 28419.6)
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1

• Select cell F4 and then point to 
the fi ll handle.

• Drag the fi ll handle down through 
cell F12 and continue to hold the 
mouse button to select the 
destination range (Figure 2–11).

Figure 2–11

source area is cell F4
initial location 
of fi ll handle

destination area 
range F5:F12

fi ll handle dragged 
through cell F12

To Copy Formulas Using the Fill Handle

The four formulas for Apple Computers in cells F4, H4, I4, and J4 now are complete. You could enter the 
same four formulas one at a time for the eight remaining stocks. A much easier method of entering the formulas, 
however, is to select the formulas in row 4 and then use the fi ll handle to copy them through row 12. Recall from 
Chapter 1 that the fi ll handle is a small rectangle in the lower-right corner of the active cell or active range. The 
following steps copy the formulas using the fi ll handle.

Entering Formulas   EX 95

Figure 2–12

Auto Fill Options 
button appears 
after copying cell F4 
to range F5:F12

initial costs of 
individual stocks

range H4:J4 selected 
as source area

2

• Release the mouse button to copy 
the formula in cell F4 to the cells 
in the range F5:F12.

• Select the range 
H4:J4 and then point to the fi ll 
handle (Figure 2–12).
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3

• Drag the fi ll handle 
down through the 
range H5:J12 to copy 
the three formulas 
=D4*G4 in cell H4, 
=H4-F4 in cell I4, 
and =I4/F4 in cell J4 
to the range H5:J12 
(Figure 2–13).

How does Excel 
adjust the cell 
references in the 
formulas in the 
destination area? 

Recall that when 
you copy a formula, 
Excel adjusts the 
cell references so 
the new formulas 
contain references 
corresponding to the 
new location and 
performs calculations 
using the appropriate 
values. Thus, if you copy downward, Excel adjusts the row portion of cell references. If you copy 
across, then Excel adjusts the column portion of cell references. These cell references are called 
relative cell references.

Figure 2–13

current value, gain/loss, 
and percent gain/loss 
formulas in range H4:J4 
copies to range H5:J12

Auto Fill Options 
button appears after 
copying the range 
H4:J4 to range H5:J12

Q
&

A

Other Ways

1. Select source area, click 
Copy button on Ribbon, 
select destination area, 
click Paste button on 
Ribbon

2. Select source area, 
right-click copy area, 
click Copy on shortcut 
menu, select destination 
area, right-click paste 
area, click Paste on 
shortcut menu

Smart Tags and Option Buttons
Excel can identify certain actions to take on specifi c data in workbooks using smart 

tags. Data labeled with smart tags includes dates, fi nancial symbols, people’s names, and 
more. To use smart tags, you must turn on smart tags using the AutoCorrect Options in 
the Excel Options dialog box. To change AutoCorrect options, click the Offi ce Button, 
click the Excel Options button on the Offi ce Button menu, point to Proofi ng, and then 
click AutoCorrect Options. Once smart tags are turned on, Excel places a small purple tri-
angle, called a smart tag indicator, in a cell to indicate that a smart tag is available. When 
you move the insertion point over the smart tag indicator, the Smart Tag Actions button 
appears. Clicking the Smart Tag Actions button arrow produces a list of actions you can 
perform on the data in that specifi c cell.

In addition to smart tags, Excel also displays Options buttons in a workbook while 
you are working on it to indicate that you can complete an operation using automatic 
features such as AutoCorrect, Auto Fill, error checking, and others. For example, the Auto 
Fill Options button shown in Figure 2–13 appears after a fi ll operation, such as dragging 
the fi ll handle. When an error occurs in a formula in a cell, Excel displays the Trace Error 
button next to the cell and identifi es the cell with the error by placing a green triangle in 
the upper left of the cell.

Table 2–4 summarizes the smart tag and Options buttons available in Excel. When 
one of these buttons appears on your worksheet, click the button arrow to produce the list 
of options for modifying the operation or to obtain additional information. 
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Table 2–4 Smart Tag and Options Buttons in Excel 

Button Name Menu Function

Auto Fill Options Gives options for how to fi ll cells following a fi ll operation, such as dragging 
the fi ll handle

AutoCorrect 
Options

Undoes an automatic correction, stops future automatic corrections of this 
type, or causes Excel to display the AutoCorrect Options dialog box

Insert Options Lists formatting options following an insertion of cells, rows, or columns

Paste Options Specifi es how moved or pasted items should appear (for example, with 
original formatting, without formatting, or with different formatting)

Smart Tag 
Actions 

Lists information options for a cell containing data recognized by Excel, such 
as a stock symbol 

Trace Error Lists error checking options following the assignment of an invalid formula 
to a cell

Entering Formulas   EX 97

To Determine Totals Using the Sum Button

The next step is to determine the totals in row 13 for the initial cost in column F, 
current value in column H, and gain/loss in column I. To determine the total initial cost 
in column F, the values in the range F4 through F12 must be summed. To do so, enter the 
function =sum(f4:f12) in cell F13 or select cell F13 and then click the Sum button on the 
Ribbon and then press the ENTER key. Recall that a function is a prewritten formula that 
is built into Excel. Similar SUM functions or the Sum button can be used in cells H13 and 
I13 to determine total current value and total gain/loss, respectively. 

1  Select cell F13. Click the Sum button on the Ribbon and then click the Enter button. 

2   Select the range H13:I13. Click the Sum button on the Ribbon to display the totals in row 
13 as shown in Figure 2–14.

Figure 2–14

total initial cost
total current value

total gain/loss

Sum button

Selecting a Range 
You can select a range 
using the keyboard. Press 
the F8 key and then use 
the arrow keys to select 
the desired range. After 
you are fi nished, make 
sure to press the F8 key 
to turn off the selection 
or you will continue to 
select ranges.

B
T
W
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To Determine the Total Percent Gain/Loss

With the totals in row 13 determined, the next step is to copy the percent gain/loss 
formula in cell J12 to cell J13 as performed in the following steps.

1  Select cell J12 and then point to the fi ll handle.

2   Drag the fi ll handle down through cell J13 to copy the formula in cell J12 to cell J13 
(Figure 2–15).

Why was the formula I13/F13 not copied to cell J13 earlier? 

 The formula, I13/F13, was not copied to cell J13 when cell J4 was copied to the range J5:J12 
because both cells involved in the computation (I13 and F13) were blank, or zero, at the 
time. A blank cell in Excel has a numerical value of zero, which would have resulted in an 
error message in cell J13. Once the totals were determined, both cells I13 and F13 
(especially F13, because it is the divisor) had nonzero numerical values.

Q
&

A

Figure 2–15

formula is =I12/F12

formula is =I13/F13

Auto Fill Options 
button appears 
after copying cell 
J12 to cell J13

Using the AVERAGE, MAX, and MIN Functions
The next step in creating the Silver Dollars Stock Club Portfolio Summary worksheet is 
to compute the average, highest value, and lowest value for the number of shares listed in 
the range D4:D12 using the AVERAGE, MAX, and MIN functions in the range D14:D16. 
Once the values are determined for column D, the entries can be copied across to the 
other columns.

Excel includes prewritten formulas called functions to help you compute these 
statistics. A function takes a value or values, performs an operation, and returns a result to 
the cell. The values that you use with a function are called arguments. All functions begin 
with an equal sign and include the arguments in parentheses after the function name. For 
example, in the function =AVERAGE(D4:D12), the function name is AVERAGE, and the 
argument is the range D4:D12.

With Excel, you can enter functions using one of fi ve methods: (1) the keyboard or 
mouse; (2) the Insert Function box in the formula bar; (3) the Sum menu; (4) the AutoSum 
command on the Formulas tab on the Ribbon; and (5) the Name box area in the formula 

Entering Functions 
You can drag the Function 
Arguments dialog box 
(Figure 2–20 on page 
EX 101) out of the way in 
order to select a range. 
You also can click the 
Collapse Dialog button to 
the right of the Number 1 
box to hide the Function 
Arguments dialog box. 
After selecting the range, 
click the Collapse Dialog 
button a second time.

B
T
W

Statistical Functions 
Excel usually considers 
a blank cell to be equal 
to 0. The statistical 
functions, however, 
ignore blank cells. Excel 
thus calculates the 
average of 3 cells with 
values of 7, blank, and 5 
to be 6 or (7 + 5) / 2 and 
not 4 or (7 + 0 + 5) / 3.

B
T
W
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Using the AVERAGE, MAX, and MIN Functions   EX 99

bar (Figure 2–16). The method you choose will depend on your typing skills and whether 
you can recall the function name and required arguments. 

In the following pages, each of the fi rst three methods will be used. The keyboard 
and mouse method will be used to determine the average number of shares (cell D14). 
The Insert Function button in the formula bar method will be used to determine the 
highest number of shares (cell D15). The Sum menu method will be used to determine 
the lowest number of shares (cell D16).

To Determine the Average of a Range of Numbers Using the Keyboard and Mouse

The AVERAGE function sums the numbers in the specifi ed range and then divides the sum by the number 
of nonzero cells in the range. The following steps use the AVERAGE function to determine the average of the 
numbers in the range D4:D12.

1
• Select cell D14.

• Type =av in the 
cell to display 
the Formula 
AutoComplete list.

• Point to the 
AVERAGE function 
name (Figure 2–16). 

What is happening 
as I type? 

As you type the 
equal sign followed 
by the characters 
in the name of 
a function, Excel 
displays the Formula 
AutoComplete list. 
This list contains 
those functions that 
alphabetically match 
the letters you have 
typed. Because you 
typed =av, Excel 
displays all the 
functions that begin 
with the letters av.

Figure 2–16

Name box changes to 
Function box as soon as 
= (equal sign) is entered 
to start function

=av typed in cell D14

ScreenTip includes 
description of currently 
selected function in 
Formula AutoComplete list

AVERAGE 
function name 

Formula 
AutoComplete list

Q
&

A
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2
• Double-click AVERAGE in the 

Formula AutoComplete list to 
select the AVERAGE function. 

• Select the range D4:D12 to insert 
the range as the argument to the 
AVERAGE function (Figure 2–17). 

As I drag, why does the 
function in cell D14 change? 

When you click cell D4, Excel 
appends cell D4 to the left 
parenthesis in the formula bar 
and surrounds cell D4 with a mar-
quee. When you begin dragging, 
Excel appends to the argument a 
colon (:) and the cell reference of 
the cell where the mouse pointer 
is located.

Figure 2–17

marquee surrounds 
selected range D4:D12

Enter box

AVERAGE function 
ScreenTip

AVERAGE function 
with range to average 
shows in active cell 
and formula bar

Q
&

A

3
• Click the Enter box to compute 

the average of the nine numbers 
in the range D4:D12 and display 
the result in cell D14 (Figure 2–18).

Can I use the arrow keys to 
complete the entry instead? 

No. When you use Point mode 
you cannot use the arrow keys to 
complete the entry. While in Point 
mode, the arrow keys change 
the selected cell reference in the 
range you are selecting.

What is the purpose of the 
parentheses in the function? 

The AVERAGE function requires 
that the argument (in this case, 
the range D4:D12) be included 
within parentheses following the 
function name. Excel automatically 
appends the right parenthesis to 
complete the AVERAGE function 
when you click the Enter box or 
press the ENTER key.

Figure 2–18

Function box changes 
back to Name box

when cell D14 is active 
cell, formula bar displays 
AVERAGE function right parenthesis 

automatically appended 
when Enter box clicked 
or ENTER key pressed

average shares 
per stock

1. Click Insert Function box in 
formula bar, click AVERAGE 
function

2. Click Sum button arrow 
on Ribbon, click Average 
function

3. Click Formulas tab on 
Ribbon, click AutoSum 
button, click Average 
function

Other Ways

Q
&

A
Q

&
A
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To Determine the Highest Number in a Range of Numbers Using the Insert 
Function Box

The next step is to select cell D15 and determine the highest (maximum) number in the range D4:D12. 
Excel has a function called the MAX function that displays the highest value in a range. Although you could 
enter the MAX function using the keyboard and Point mode as described in the previous steps, an alternative 
method to entering the function is to use the Insert Function box in the formula bar, as performed in the 
following steps.

1
• Select cell D15.

• Click the Insert Function box in the 
formula bar to display the Insert 
Function dialog box.

• When Excel displays the Insert 
Function dialog box, click MAX 
in the ‘Select a function list’ 
(Figure 2–19).

Figure 2–19

Using the AVERAGE, MAX, and MIN Functions   EX 101

Figure 2–20

Function Arguments 
dialog box range typed in 

Number 1 box Collapse 
Dialog button

Help on this 
function link

last part of function 
appears in active cell

OK button

fi rst few numbers 
in selected range

result of function

2
• Click the OK button.

• When Excel displays the Function 
Arguments dialog box, type 
d4:d12 in the Number 1 box 
(Figure 2–20).

Why did numbers appear in the 
Function Arguments dialog box? 

As shown in Figure 2–20, Excel dis-
plays the value the MAX function 
will return to cell D15 in the Func-
tion Arguments dialog box. It also 
lists the fi rst few numbers in the 
selected range, next to the 
Number 1 box.

Q
&

A

Search for a 
function box

Insert Function 
dialog box

Or select a 
category box

MAX selected in 
Select a function list

equal sign 
automatically 
inserted in active 
cell and formula bar 

Help on this 
function link

OK button

Insert Function box
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3
• Click the OK button to display the 

highest value in the range D4:D12 
in cell D15 (Figure 2–21).

Why should I not just enter the 
highest value that I see in the 
range D4:D12 in cell D15? 

In this example, rather than 
entering the MAX function, 
you easily could scan the range 
D4:D12, determine that the 
highest number of shares is 990, 
and manually enter the number 
990 as a constant in cell D15. 
Excel would display the number 
the same as in Figure 2–21. Because 
it contains a constant, however, 
Excel will continue to display 990 
in cell D15, even if the values in 
the range D4:D12 change. If you 
use the MAX function, Excel will 
recalculate the highest value in 
the range D4:D9 each time a new 
value is entered into the worksheet. 

Figure 2–21

MAX function 
determines 
highest value in 
range D4:D12 

highest value in 
range D4:D12

Q
&

A

To Determine the Lowest Number in a Range of Numbers Using the Sum Menu

The next step is to enter the MIN function in cell D16 to determine the lowest (minimum) number in the 
range D4:D12. Although you can enter the MIN function using either of the methods used to enter the AVERAGE 
and MAX functions, the following steps perform an alternative using the Sum button on the Ribbon.

1
• Select cell D16.

• Click the Sum button arrow on the 
Ribbon to display the Sum button 
menu (Figure 2–22). 

Why should I use the Sum 
button menu? 

Using the Sum button menu allows 
you to enter one of fi ve often-used 
functions easily into a cell, without 
having to memorize its name or the 
required arguments. 

Q
&

A

Figure 2–22

Sum button arrow

Sum button menu

Min function

D16 is active cell

1. Click Sum button arrow on 
Ribbon, click Max function

2. Click Formulas tab on 
Ribbon, click AutoSum 
button, click Max function

3. Type =MAX in cell

Other Ways
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2
• Click Min to display the function 

=MIN(D14:D15) in the formula bar 
and in cell D16 (Figure 2–23). 

Why does Excel select the 
range D14:D15? 

The range D14:D15 automatically 
selected by Excel is not correct. 
Excel attempts to guess which 
cells you want to include in the 
function by looking for adjacent 
ranges to the selected cell that 
contain numeric data.

Figure 2–23

MIN function appears 
in formula bar

Excel selects range 
D14:D15 because it 
includes numbers and 
is adjacent to cell D16

MIN function appears 
in active cell D16

Figure 2–24

3
• Click cell D4 and then drag 

through cell D12 to display the 
function in the formula bar and 
in cell D14 with the new range 
(Figure 2–24).

Q
&

A
Using the AVERAGE, MAX, and MIN Functions   EX 103

range D4:D12 selected 
using Point mode

selected range 
appears in active cell 
and in formula bar

Enter box
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4
• Click the Enter box to determine 

the lowest value in D4:D12 and 
display the result in the formula 
bar and in cell D14 (Figure 2–25).

How can I use other functions? 

Excel has more than 400 additional 
functions that perform just about 
every type of calculation you can 
imagine. These functions are cat-
egorized in the Insert Function 
dialog box shown in Figure 2–19
on page EX 101. To view the 
categories, click the ‘Or select a 
category‘ box arrow. To obtain a 
description of a selected function, 
select its name in the Insert 
Function dialog box. Excel displays 
the description of the function 
below the Select a function list in 
the dialog box.

Figure 2–25

MIN function 
determines lowest 
value in range D4:D12

result of MIN function 
appears in cell

Q
&

A

To Copy a Range of Cells across Columns to an Adjacent Range Using the Fill Handle

The next step is to copy the AVERAGE, MAX, and MIN functions in the range D14:D16 to the adjacent 
range E14:J16. The following steps use the fi ll handle to copy the functions.

1
• Select the 

range D14:D16.

• Drag the fi ll handle 
in the lower-right 
corner of the 
selected range 
through cell J16 and 
continue to hold 
down the mouse 
button (Figure 2–26).

Figure 2–26

copy range D14:D16 
selected

fi ll handle dragged 
to select destination 
area, range E14:J16

mouse pointer

1. Click Insert Function box 
in formula bar, click MIN 
function

2. Click Formulas tab on 
Ribbon, click AutoSum 
button, click Min function

3. Type =MIN in cell

Other Ways
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2
• Release the mouse button to copy 

the three functions to the range 
E14:J16 (Figure 2–27).

How can I be sure that the 
function arguments are proper 
for the cells in range E14:J16? 

Remember that Excel adjusts 
the cell references in the copied 
functions so each function refers 
to the range of numbers above it 
in the same column. Review the 
numbers in rows 14 through 16 
in Figure 2–27. You should see 
that the functions in each column 
return the appropriate values, 
based on the numbers in rows 4 
through 12 of that column.

AVERAGE, MAX, and 
MIN functions in 
range D14:D16 copied 
to range E14:J16

Figure 2–27

Q
&

A

3
• Select cell J14 and press the 

DELETE key to delete the 
average of the percent 
gain/loss (Figure 2–28).

Why is the formula in cell J14 
deleted? 

The average of the percent gain/
loss in cell J14 is deleted because 
an average of percentages of this 
type is mathematically invalid.

Q
&

A

Figure 2–28

Save button

average percents 
in range J4:J12 
mathematically 
invalid

Other Ways

1. Select source area and 
point to border of 
range, while holding 
down CTRL key, 
drag source area to 
destination area

2. Select source area, 
on Ribbon click 
Copy button, select 
destination area, on 
Ribbon click Paste 
button

3. Right-click source area, 
click Copy on shortcut 
menu, right-click 
destination area, click 
Paste on shortcut menu

4. Select source area, 
press CTRL+C, select 
destination area, press 
CTRL+V

Using the AVERAGE, MAX, and MIN Functions   EX 105

Auto Fill Options 
button
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To Save a Workbook Using the Same File Name

Earlier in this project, an intermediate version of the workbook was saved using the fi le name, Silver Dollars 
Stock Club Portfolio Summary. The following step saves the workbook a second time using the same fi le name.

1  Click the Save button on the Quick Access toolbar to save the workbook on the USB fl ash 
drive using the fi le name, Silver Dollars Stock Club Portfolio Summary.

Why did Excel not display the Save As dialog box? 

 When you save a workbook a second time using the same fi le name, Excel will not display 
the Save As dialog box as it does the fi rst time you save the workbook. Excel automati-
cally stores the latest version of the workbook using the same fi le name, Silver Dollars 
Stock Club Portfolio Summary. You also can click Save on the Offi ce Button menu or press 
SHIFT+F12 or CTRL+S to save a workbook again.

Verifying Formulas Using Range Finder
One of the more common mistakes made with Excel is to include a wrong cell reference in a 
formula. An easy way to verify that a formula references the cells you want it to reference 
is to use Excel’s Range Finder. Use the Range Finder to check which cells are referenced 
in the formula assigned to the active cell. Range Finder allows you to make immediate 
changes to the cells referenced in a formula.

To use Range Finder to verify that a formula contains the intended cell references, 
double-click the cell with the formula you want to check. Excel responds by highlighting 
the cells referenced in the formula so you can check that the cell references are correct. 

Q
&

A

1
• Double-click cell J4 to activate 

Range Finder (Figure 2–29).

2
• Press the ESC key to quit Range 

Finder and then select 
cell A18.

To Verify a Formula Using Range Finder

The following steps use Range Finder to check the formula in cell J4.

Figure 2–29

color of cell 
references 
corresponds to color 
of highlighted cells

cells referenced in 
formula in active cell 
are highlighted with 
corresponding colors

C6161_EXC_02.4c.indd   106C6161_EXC_02.4c.indd   106 3/6/07   3:28:41 PM3/6/07   3:28:41 PM



Ex
ce

l 
C

h
ap

te
r 

2
Ex

ce
l 

C
h

ap
te

r 
2

Formatting the Worksheet
Although the worksheet contains the appropriate data, formulas, and functions, the text 
and numbers need to be formatted to improve their appearance and readability.

In Chapter 1, cell styles were used to format much of the worksheet. This section 
describes how to change the unformatted worksheet in Figure 2–30a to the formatted 
worksheet in Figure 2–30b using a theme and other commands on the Ribbon. A theme 
is a predefi ned set of colors, fonts, chart styles, cell styles, and fi ll effects that can be 
applied to an entire workbook. Every new workbook that you create is assigned a default 
theme named Offi ce. The colors and fonts that are used in the worksheet shown in 
Figure 2–30b are those that are associated with the Concourse theme. 

Formatting the Worksheet   EX 107

(a)  Unformatted 
Worksheet

(b) Formatted Worksheet

Figure 2–30

turquoise background

Title cell style applied 
to title and subtitle

row height increased

column titles centered thick box border 
surrounds worksheet 
title and subtitle

Heading 3 cell style 
applied to row 3

negative numbers 
displayed with light-
red background

Total cell style 
applied to row 13

Comma style format

row height increased

data centered 
in cells

dates formatted 
to mm/dd/yy style Currency style format

Percent style format

column width changed
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Identify how to format various elements of the worksheet.
The following outlines the formatting suggested in the sketch of the worksheet in Figure 2–3 
on page EX 85:

1.  Workbook theme - Concourse

2. Worksheet title and subtitle

 a. Alignment — center across columns A through J 

 b. Cell style —Title

 c. Font size — title 18; subtitle 16

 d. Background color (range A1:J2) — Turquoise Accent 1, Lighter 60%

 e. Border — thick box border around range A1:J2

3. Column titles

 a. Cell style — Heading 3

 b. Alignment — center

4. Data

 a. Alignment — center data in column B

 b. Dates in column C — mm/dd/yy format

 c. Numbers in top row (range E4:I4) — Accounting style

 d. Numbers below top row (range E5:I12) — Comma style and decimal places

5. Total line

 a. Cell style — Total

 b. Numbers — Accounting style

6. Average, Highest, and Lowest rows

 a. Font style of row titles in range A14:A16 — bold 

 b. Numbers — Currency style with fl oating dollar sign in the range E14:I16

7. Percentages in column J

 a.  Numbers — Percentage style with two decimal places; if a cell in range J4:J12 is less 
than zero, then cell appears with background color of light red

8. Column widths

 a. Column A — 14.11 characters

 b. Columns B and C — best fi t

 c. Column D — 6.00 characters

 d. Column E, G, and J — 9.00 characters

 e. Columns F, H, and I — 12.67 characters

9. Row heights

 a. Row 3 — 60.00 points

 b. Row 14 — 26.25 points

 c. Remaining rows — default

Plan 
Ahead

Colors
Knowing how people 
perceive colors helps 
you emphasize parts of 
your worksheet. Warmer 
colors (red and orange) 
tend to reach toward 
the reader. Cooler colors 
(blue, green, and violet) 
tend to pull away from 
the reader. Bright colors 
jump out of a dark 
background and are 
easiest to see. White or 
yellow text on a dark 
blue, green, purple, or 
black background 
is ideal.

B
T
W
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2

• Click Concourse in the Theme 
gallery to change the workbook 
theme to Concourse (Figure 2–32).

Why did the cells in the worksheet 
change? 

The cells in the worksheet originally 
were formatted with the default 
font for the default Offi ce theme. 
The default font for the Concourse 
theme is different than that of the 
default font for the Offi ce theme 
and therefore changed on the 
worksheet when you changed the 
theme. If you had modifi ed the font 
for any of the cells, those cells would 
not receive the default font for the 
Concourse theme.

To Change the Workbook Theme

The Concourse theme includes fonts and colors that provide the worksheet a professional and subtly colored 
appearance. The following steps change the workbook theme to the Concourse theme.

1
• Click the Page Layout tab on the 

Ribbon.

• Click the Themes button on the 
Ribbon to display the Theme gal-
lery (Figure 2–31).

I Experiment

• Point to several themes in the 
Theme gallery to see a live 
preview of the themes.

Why should I change the theme of 
a workbook? 

A company or department may 
standardize on a specifi c theme so 
that all of their documents have 
a similar appearance. Similarly, 
an individual may want to have a 
theme that sets their work apart 
from others. Other Offi ce applica-
tions, such as Word and Power-
Point, include the same themes 
included with Excel, meaning that 
all of your Microsoft Offi ce documents 
can share a common theme.

Q
&

A

Figure 2–32

Home tab

font of worksheet 
cells refl ects theme’s 
default font

Q
&

A

Figure 2–31

Page Layout tab

Themes button

Current theme

Concourse theme

Theme gallery
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To Format the Worksheet Titles

The following steps merge and center the worksheet titles, apply the Title cells style 
to the worksheet titles, and decrease the font of the worksheet subtitle.

1  Click the Home tab on the Ribbon.

2  Select the range A1:J1 and then click the Merge and Center button on the Ribbon.

3  Select the range A2:J2 and then click the Merge and Center button on the Ribbon.

4  Select the range A1:A2, click the Cell Styles button on the Ribbon, and then click the Title 
cell style in the Cell Styles gallery.

5  Select cell A2 and then click the Decrease Font Size button on the Ribbon (Figure 2–33).

What is the effect of clicking the Decrease Font Size button? 

When you click the Decrease Font Size button Excel assigns the next lowest font size in the 
Font Size gallery to the selected range. The Increase Font Size button works in a similar 
manner, but causes Excel to assign the next highest font size in the Font Size gallery to the 
selected range.

Figure 2–33 

Increase Font 
Size button

Decrease Font 
Size button

Merge and 
Center button

Cell Styles button

font size of worksheet 
subtitle decreased

Q
&

A

To Change the Background Color and Apply a Box Border to the Worksheet Title 
and Subtitle

The fi nal formats assigned to the worksheet title and subtitle are the turquoise background color and thick 
box border (Figure 2–30b on page EX 107). The following steps complete the formatting of the worksheet titles.

1
• Select the range A1:A2 

and then click the 
Fill Color button 
arrow on the Ribbon 
to display the Fill 
Color palette 
(Figure 2–34).

Figure 2–34

Fill Color button arrow

desired 
background color

Fill Color palette

range A1:A2 is 
active range

Background Colors 
The most popular 
background color is 
blue. Research shows 
that the color blue is 
used most often because 
this color connotes 
serenity, refl ection, and 
profi ciency.

B
T
W
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Formatting the Worksheet   EX 111

2
• Click Turquoise 

Accent 1, lighter 
60% (column 5, 
row 3) on the Fill 
Color palette to 
change the back-
ground color of 
cells A1 and A2 
from white to 
turquoise 
(Figure 2–35). 

Figure 2–35

background of 
range A1:A2 is 
turquoise

3
• Click the Borders 

button arrow on the 
Ribbon to display 
the Borders gallery 
(Figure 2–36).

Figure 2–36

Borders button arrow

Borders gallery

desired border
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4
• Click the Thick Box Border 

command on the Borders gal-
lery to display a thick box border 
around the range A1:A2.

• Click cell A18 to deselect the 
range A1:A2 (Figure 2–37).

Figure 2–37

Format Cells: Number 
Dialog Box Launcher 
button

thick box border 
surrounds worksheet 
title and subtitle in 
cells A1:A2

To Apply a Cell Style to the Column Headings and Format the 
Total Rows

As shown in Figure 2–30b on page EX 107, the column titles (row 3) have the 
Heading 3 cell style and the total row (row 13) has the Total cell style. The summary 
information headings in the range A14:A16 should be bold. The following steps assign 
these styles to row 3 and row 13 and the range A14:A16. 

1  Select the range A3:J3.

2  Apply the Heading 3 cell style to the range A3:J3.

3  Apply the Total cell style to the range A13:J13.

4  Select the range A14:A16 and then click the Bold button on the Ribbon (Figure 3-38).

Figure 2–38

Bold button

range A14:A16 
formatted bold

total row formatted 
with Total cell style

column headings 
formatted with 
Heading 3 cell style

Other Ways

1. On Ribbon click Format 
Cells Dialog Box Launcher, 
click appropriate tab, click 
desired format, click OK 
button

2. Right-click range, click 
Format Cells on shortcut 
menu, click appropriate 
tab, click desired 
format, click OK button

3. Press CTRL+1, click 
appropriate tab, click 
desired format, click OK 
button

Center button Format Cells Dialog 
Box Launcher
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To Center Data in Cells and Format Dates 

With the column titles and total rows formatted, the next step is to center the stock symbols in column B and 
format the dates in column C. If a cell entry is short, such as the stock symbols in column B, centering the entries 
within their respective columns improves the appearance of the worksheet. The following steps center the data in 
the range B4:B12 and format the dates in the range C4:C12.

1
• Select the range B4:B12 and 

then click the Center button 
on the Ribbon to center the 
data in the range B4:B12.

2
• Select the range C4:C12.

• Click the Format Cells:
Number Dialog Box 
Launcher on the Ribbon 
to display the Format Cells 
dialog box.

• When Excel 
displays the Format Cells 
dialog box, if necessary 
click the Number tab, click 
Date in the Category list, 
and then click 3/14/01 in 
the Type list to choose the 
format for the range C4:C12 
(Figure 2–39).

Figure 2–39

Format Cells 
dialog box Number tab

Date selected in 
Category list

3/14/01 style 
selected in 
Type list

data centered 
in range B4:B12

dates in range 
C4:C12 selected

OK button

Formatting the Worksheet   EX 113
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Formatting Numbers Using the Ribbon
As shown in Figure 2–30b on page EX 107, the worksheet is formatted to resemble 

an accounting report. For example, in columns E through I, the numbers in the fi rst row 
(row 4), the totals row (row 13), and the rows below the totals (rows 14 through 16) have 
dollar signs, while the remaining numbers (rows 5 through 12) in columns E through I 
do not. 

To append a dollar sign to a number, you should use the Accounting number format. 
Excel displays numbers using the Accounting Number Format with a dollar sign to the 
left of the number, inserts a comma every three positions to the left of the decimal point, and 
displays numbers to the nearest cent (hundredths place). Clicking the Accounting Number 
Format button on the Ribbon assigns the desired accounting number format. When you 
use the Accounting Number Format button to assign the accounting number format, Excel 
displays a fi xed dollar sign to the far left in the cell, often with spaces between it and the fi rst 
digit. To assign a fl oating dollar sign that appears immediately to the left of the fi rst digit 
with no spaces, use the Currency Style in the Format Cells dialog box. 

The Comma Style format is used to instruct Excel to display numbers with commas 
and no dollar signs. The Comma Style format, which can be assigned to a range of cells by 
clicking the Comma Style button on the Ribbon, inserts a comma every three positions to 
the left of the decimal point and causes numbers to be displayed to the nearest hundredths.

3
• Click the OK button to format the 

dates in column C using the date 
format style, mm/dd/yy.

• Select cell E4 to deselect the 
range C4:C13 (Figure 2–40).

Can I format an entire column 
at once? 

Yes. Rather than selecting the 
range B4:B12 in Step 1, you could 
have clicked the column B heading 
immediately above cell B1, and 
then clicked the Center button on 
the Ribbon. In this case, all cells in 
column B down to the last cell in 
the worksheet would have been 
formatted to use center alignment. 
This same procedure could have 
been used to format the dates in 
column C.

Figure 2–40

Excel displays dates 
in range C4:C12 
using date style 
format, mm/dd/yy

Q
&

A

Other Ways

1. Right-click range, click 
Format Cells on shortcut 
menu, click appropriate 
tab, click desired 
format, click OK button

2. Press CTRL+1, click 
appropriate tab, click 
desired format, 
click OK button

Rotating and Shrinking 
Entries in Cells 
In addition to aligning 
entries horizontally and 
vertically, you also can 
rotate and shrink entries 
to fi t in a cell. To rotate 
or shrink entries to fi t in 
a cell, click Format Cells 
on the shortcut menu, 
click the Alignment tab 
in the Format Cells dialog 
box, and then select the 
type of control you want.

B
T
W
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To Apply an Accounting Style Format and Comma Style Format Using the Ribbon

The following steps show how to assign formats using the Accounting Number Format button and the 
Comma Style button on the Ribbon. 

1
• Select the range E4:I4.

• While holding down the CTRL key, 
select the ranges F13:I13.

• Click the Accounting Number 
Format button on the Ribbon 
(Figure 2–41) to apply the 
Accounting style format with fi xed 
dollar signs to the nonadjacent 
ranges E4:I4 and F13:I13 
(Figure 2–41).

What is the effect of applying the 
Accounting style format? 

The Accounting Number Format 
button assigns a fi xed dollar sign 
to the numbers in 
the ranges E4:I4 and 
F13:I13. In each cell in 
these ranges, Excel dis-
plays the dollar sign to 
the far left with spaces between it 
and the fi rst digit in the cell. 

Figure 2–41

Accounting Number 
Format button

Excel displays nonadjacent 
ranges E4:I4 and F13:I13 using 
the Accounting style format 
with fi xed dollar signs

Q
&

A
Formatting the Worksheet   EX 115

2
• Select the range E5:I12.

• Click the Comma Style button on 
the Ribbon to assign the Comma 
style format to the range E5:I12 
(Figure 2–42).

Figure 2–42

Comma Style button

range E5:I12 selected

Excel displays range 
E5:I12 using Comma 
style format

parentheses indicate 
number is negative

width of columns 
automatically 
increased due to 
formatting
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3
• Click cell E4. 

• While holding down the CTRL key, 
select cell G4. 

• Click the Increase Decimal button 
on the Ribbon to increase the 
number of decimal places dis-
played in cell E4 and G4. 

• Select the range E5:E12. While 
holding down the CTRL key, select 
the range G5:G12. 

• Click the Increase Decimal button on 
the Ribbon to increase the num-
ber of decimal places displayed in 
selected ranges (Figure 2–43).

What is the effect of clicking the 
Increase Decimal button? 

The Increase Decimal button 
instructs Excel to display additional decimal places in a cell. Each time you click the Increase Decimal button, Excel adds 
a decimal place to the selected cell.

Increase Decimal 
button

Decrease Decimal 
button

Excel displays 
numbers to three 
decimal places

Q
&

A

To Apply a Currency Style Format with a Floating Dollar Sign Using the Format Cells 
Dialog Box

The following steps use the Format Cells dialog box to apply the Currency style format with a fl oating dollar 
sign to the numbers in the ranges E14:I16.

1
• Select the range E14:I16 and 

then point to the Format Cells: 
Number Dialog Box Launcher on 
the Ribbon (Figure 2–44).

Figure 2–44

Format Cells: Number 
Dialog Box Launcher 

Enhanced ScreenTip

range E14:I16 
selected

Figure 2–43
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2
• Click the Format Cells: Number 

Dialog Box Launcher.

• If necessary, click the Number tab 
in the Format Cells dialog box.

• Click Currency in the Category 
list and then click the third style 
($1,234.10) in the Negative 
numbers list (Figure 2–45).

How do I select the proper format? 

You can choose from 12 categories 
of formats. Once you select a 
category, you can select the number 
of decimal places, whether or not 
a dollar sign should be displayed, 
and how negative numbers 
should appear. Selecting the 
appropriate negative numbers 
format is important, because doing 
so adds a space to the right of 
the number in order to align the 
numbers in the worksheet on 
the decimal points. Some of 
the available negative number 
formats do not align the numbers 
in the worksheet on the decimal 
points. Figure 2–45

Currency style 
selected

number of 
decimal places

$ symbol selected

OK button

Negative numbers list

sample of how 
number in upper-left 
cell of selected range 
will appear

Number tab

Format Cells 
dialog box

3
• Click the OK button to assign 

the Currency style format with a 
fl oating dollar sign to the 
range E14:I16 (Figure 2–46).

Should I click the Accounting 
Number Style button on the 
Ribbon or use the Format Cells 
dialog box? 

Recall that a fl oating dollar sign 
always appears immediately to 
the left of the fi rst digit, and the 
fi xed dollar sign always appears 
on the left side of the cell. Cell E4, 
for example, has a fi xed dollar 
sign, while cell E14 has a fl oating 
dollar sign. The Currency style 
was assigned to cell E14 using the 
Format Cells dialog box and the result is a fl oating dollar sign.

Q
&

A

Figure 2–46

Excel displays range 
E14:I16 using Currency 
style format with 
fl oating dollar signs

parentheses surround 
negative numbersQ

&
A

1. Press CTRL+1, click Number 
tab, click Currency in 
Category list, select format, 
click OK button

2. Press CTRL+SHIFT+
DOLLAR SIGN ($)

Other Ways
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To Apply a Percent Style Format and Use the Increase Decimal Button

The next step is to format the percent gain/loss in column J. Currently, Excel displays the numbers in column J 
as a decimal fraction (for example, 0.284874 in cell J4). The following steps format the range J4:J16 to the Percent style 
format with two decimal places.

1
• Select the range J4:J16.

• Click the Percent Style button on 
the Ribbon to display the numbers 
in column J as a rounded whole 
percent.

What is the result of clicking the 
Percent Style button? 

The Percent Style button instructs 
Excel to display a value as a 
percentage, determined by 
multiplying the cell entry by 100, 
rounding the result to the nearest 
percent, and adding a percent 
sign. For example, when cell J4 is 
formatted using the Percent Style 
and Increase Decimal buttons, 
Excel displays the actual value 
0.284874 as 28.49%.

2
• Click the Increase Decimal button 

on the Ribbon two times to display 
the numbers in column J with 
the Percent style format and two 
decimal places (Figure 2–47).

Figure 2–47

Percent Style button
Increase 
Decimal button

Decrease 
Decimal button

Excel displays range 
J4:J16 using Percent 
style format with two 
decimal places

Other Ways

1. Right-click range, click 
Format Cells on shortcut 
menu, click Number 
tab, click Percentage 
in Category list, select 
format, click OK button

2. Press CTRL+1, click 
Number tab, click 
Percentage in Category 
list, select format, click 
OK button

3. Press CTRL+SHIFT+ 
PERCENT SIGN (%)

Conditional Formatting
The next step is to emphasize the negative percentages in column J by formatting 

them to appear with a tinted background. The Conditional Formatting button on the 
Ribbon will be used to complete this task.

Excel lets you apply formatting that appears only when the value in a cell meets 
conditions that you specify. This type of formatting is called conditional formatting. 
You can apply conditional formatting to a cell, a range of cells, the entire worksheet, or 
the entire workbook. Usually, you apply conditional formatting to a range of cells that 
contains values you want to highlight, if conditions warrant. For example, you can instruct 
Excel to change the color of the background of a cell if the value in the cell meets a condition, 
such as being less than 0 as shown in Figure 2–48. 

A condition, which is made up of two values and a relational operator, is true or 
false for each cell in the range. If the condition is true, then Excel applies the formatting. 
If the condition is false, then Excel suppresses the formatting. What makes conditional 
formatting so powerful is that the cell’s appearance can change as you enter new values in 
the worksheet. 

Q
&

A

C6161_EXC_02.4c.indd   118C6161_EXC_02.4c.indd   118 3/6/07   3:29:08 PM3/6/07   3:29:08 PM



Ex
ce

l 
C

h
ap

te
r 

2
Ex

ce
l 

C
h

ap
te

r 
2

Formatting the Worksheet   EX 119

To Apply Conditional Formatting

The following steps assign conditional formatting to the range J4:J12, so that any cell value less than zero will 
cause Excel to display the number in the cell with a light red background.

1
• Select the range J4:J12.

• Click the Conditional Formatting  
button on the Ribbon to display 
the Conditional Formatting 
gallery (Figure 2–48).

2
• Click New Rule in the Conditional 

Formatting gallery to display the 
New Formatting Rule dialog box.

• Click ‘Format only cells that 
contain‘ in the Select a Rule 
Type area.

• In the Edit the Rule 
Description area, click the 
box arrow in the relational 
operator box (second text 
box) and then select less than. 

• Type 0 (zero) in the rightmost
box in the Edit the Rule 
Description area (Figure 2–49).

Figure 2–48

Conditional 
Formatting button

Conditional 
Formatting gallery

New Rule command

range J4:J12 selected

Figure 2–49

New Formatting 
Rule dialog box

Select a Rule Type list

value 1

relational operator

Edit the Rule 
Description area

Format button

value 2
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3
• Click the Format 

button.

• When Excel displays 
the Format Cells 
dialog box, click the 
Fill tab and then click 
the light red color 
in column 6, row 2 
(Figure 2–50).

Figure 2–50

desired font color

Sample area 
displays font color

OK button

4
• Click the OK button 

to close the Format 
Cells dialog box and 
display the New 
Formatting Rule 
dialog box with 
the desired color 
displayed in the 
Preview box 
(Figure 2–51).

Figure 2–51

New Formatting 
Rule dialog box

Preview box displays 
format assigned to cell in 
selected range if value in 
cell is less than 0

OK button
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5
• Click the OK button 

to assign the condi-
tional format to the 
range J4:J12.

• Click cell A18 to 
deselect the range 
J4:J12 (Figure 2–52).

Figure 2–52

Excel displays negative 
numbers in range J4:J12
with a light red background

Conditional Formatting Operators
As shown in Figure 2–49 on page EX 119, the second text box in the New Formatting 

Rule dialog box allows you to select a relational operator, such as less than, to use in the con-
dition. The eight different relational operators from which you can choose for conditional 
formatting in the New Formatting Rule dialog box are summarized in Table 2–5.

Table 2–5 Summary of Conditional Formatting Relational Operators 

Relational Operator Description

Between Cell value is between two numbers

Not between Cell value is not between two numbers

Equal to Cell value is equal to a number

Not equal to Cell value is not equal to a number

Greater than Cell value is greater than a number

Less than Cell value is less than a number

Greater than or equal to Cell value is greater than or equal to a number

Less than or equal to Cell value is less than or equal to a number

Conditional 
Formatting 
You can assign any 
format to a cell, a range 
of cells, a worksheet, 
or an entire workbook 
conditionally. If the 
value of the cell changes 
and no longer meets 
the specifi ed condition, 
Excel suppresses the 
conditional formatting.

B
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Changing the Widths of Columns and Heights of Rows
When Excel starts and displays a blank worksheet on the screen, all of the columns 

have a default width of 8.43 characters, or 64 pixels. A character is defi ned as a letter, 
number, symbol, or punctuation mark in 11-point Calibri font, the default font used by 
Excel. An average of 8.43 characters in 11-point Calibri font will fi t in a cell. 

Another measure of the height and width of cells is pixels, which is short for picture 
element. A pixel is a dot on the screen that contains a color. The size of the dot is based 
on your screen’s resolution. At a common resolution of 1024 � 768, 1024 pixels appear 
across the screen and 768 pixels appear down the screen for a total of 786,432 pixels. It is 
these 786,432 pixels that form the font and other items you see on the screen.

The default row height in a blank worksheet is 15 points (or 20 pixels). Recall 
from Chapter 1 that a point is equal to 1/72 of an inch. Thus, 15 points is equal to 
about 1/5 of an inch. You can change the width of the columns or height of the rows at 
any time to make the worksheet easier to read or to ensure that Excel displays an entry 
properly in a cell. 

To Change the Widths of Columns

When changing the column width, you can set the width manually or you can instruct Excel to size the column 
to best fi t. Best fi t means that the width of the column will be increased or decreased so the widest entry will fi t in the 
column. Sometimes, you may prefer more or less white space in a column than best fi t provides. Excel thus allows you 
to change column widths manually.

When the format you assign to a cell causes the entry to exceed the width of a column, Excel automatically 
changes the column width to best fi t. If you do not assign a format to a cell or cells in a column, the column width 
will remain 8.43 characters. To set a column width to best fi t, double-click the right boundary of the column heading 
above row 1.

The following steps change the column widths: column A to 14.11 characters; columns B and C to best fi t; 
column D to 6.00 characters; columns E, G, and J to 9.00 characters; and columns F, H, and I to 12.67 characters. 

Figure 2–53

dotted line shows 
proposed right 
border of column A

ScreenTip shows 
proposed column 
width

current right border 
of column A

mouse pointer

1
• Point to the boundary on the right 

side of the column A heading 
above row 1.

• When the mouse pointer changes 
to a split double arrow, drag until 
the ScreenTip indicates Width: 
14.11 (134 pixels). Do not release 
the mouse button (Figure 2–53).

What happens if I change the 
column width to zero (0)? 

If you decrease the column width to 
0, the column is hidden. Hiding cells 
is a technique you can use to hide 
data that might not be relevant to 
a particular report or sensitive data 
that you do not want others to see. 
To instruct Excel to display a hidden 
column, position the mouse pointer 
to the right of the column heading 
boundary where the hidden column 
is located and then drag to the right.

Q
&

A

Hidden Columns 
Trying to unhide a range 
of columns using the 
mouse can be frustrating. 
An alternative is to use 
the keyboard: select the 
columns to the right 
and left of the hidden 
columns and then press 
CTRL+SHIFT+) (RIGHT 
PARENTHESIS). To use the 
keyboard to hide a range 
of columns, press CTRL+0 
(ZERO).

B
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2
• Release the mouse button.

• Drag through column headings B 
and C above row 1.

• Point to the boundary on the 
right side of column heading C 
to cause the mouse pointer to 
become a split double arrow 
(Figure 2–54).

What if I want to make a large 
change to the column width? 

If you want to increase or decrease 
column width signifi cantly, you 
can right-click a column heading 
and then use the Column Width 
command on the shortcut menu 
to change the column’s width. To 
use this command, however, you 
must select one or more entire 
columns. 

new column A width

mouse pointer 
pointing to right 
boundary of column C

Figure 2–54

columns B and C 
selected

3
• Double-click the right boundary 

of column heading C to change 
the width of columns B and C to 
best fi t.

• Click the column E heading 
above row 1.

• While holding down the CTRL key, 
click the column G heading and 
then the column J heading above 
row 1 so that columns E, G, and J 
are selected.

• Point to the boundary on the 
right side of the column J heading 
above row 1.

• Drag until the ScreenTip indicates 
Width: 9.00 (88 pixels). Do not 
release the mouse button 
(Figure 2–55).

Figure 2–55

mouse pointer

current right 
border of column J

ScreenTip shows 
proposed column width

dotted line shows 
proposed right 
border of column J

column widths B and C 
are set to best fi t

columns E, G, 
and J selected

Q
&

A
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4
• Release the 

mouse button.

• Click the 
column F heading 
above row 1 to 
select column F.

• While holding 
down the CTRL key, 
click the column H 
heading and then 
the column I 
heading above 
row 1, to select 
columns F, H, and I.

• Point to the 
boundary on the 
right side of the 
column I heading 
above row 1.

• Drag to the left 
until the ScreenTip 
indicates Width: 
12.67 (121 pixels). 
Do not release 
the mouse button 
(Figure 2–56).

mouse pointer

ScreenTip shows 
proposed column width

dotted line shows 
proposed right 
border of column I

Figure 2–56

column widths of 
E, G, and J set to 
9.00 characters

columns F, H, 
and I selected

5
• Release the 

mouse button.

• Point to the 
boundary on the 
right side of the 
column D heading 
above row 1. 

• Drag to the left 
until the ScreenTip 
indicates Width: 6.00 
(61 pixels) and then 
release the mouse 
button to display the 
worksheet with the 
new column widths.

• Click cell A18 to deselect 
columns F, H, and I (Figure 2–57).

width of column D 
set to 6.00 characters

width of column A set 
to 14.11 characters

width of columns B 
and C set to best fi t

Figure 2–57

widths of columns 
E, G, and J set to 
9.00 characters

widths of columns F, 
H, and I set to 12.67 
characters

1. Right-click column heading 
or drag through multiple 
column headings and right-
click, click Column Width on 
shortcut menu, enter desired 

column width, click OK 
button

2. Right-click column heading 
or drag through multiple 
column headings and right-

click, click Format button on 
Ribbon, click Column Width 
in Format gallery, enter 
desired column width, click 
OK button

Other Ways
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To Change the Heights of Rows

When you increase the font size of a cell entry, such as the title in cell A1, Excel automatically increases the 
row height to best fi t so it can display the characters properly. Recall that Excel did this earlier when multiple lines 
were entered in a cell in row 3, and when the cell style of the worksheet title and subtitle was changed.

You also can increase or decrease the height of a row manually to improve the appearance of the worksheet. 
The following steps show how to improve the appearance of the worksheet by decreasing the height of row 3 to 
60.00 points, and increasing the height of row 14 to 26.25 points.

1
• Point to the 

boundary below row 
heading 3.

• Drag up until the 
ScreenTip indicates 
Height: 60.00 
(80 pixels). Do not 
release the mouse 
button (Figure 2–58).

mouse pointer

current bottom 
border of row 3

ScreenTip 
shows proposed 
height of row 3

dotted line shows 
proposed bottom 
border of row 3

Figure 2–58
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3
• Release the mouse button to 

change the row height of row 14 
to 26.25.

• Select cells A3:J3 and then click 
the Center button on the Ribbon 
to center the column headings.

• Select cell A18 (Figure 2–60).

Can I hide a row? 

Yes. As with column widths, when 
you decrease the row height to 
0, the row is hidden. To instruct 
Excel to display a hidden row, 
position the mouse pointer just 
below the row heading boundary 
where the row is hidden and then 
drag down. To set a row height to 
best fi t, double-click the bottom 
boundary of the row heading.

2
• Release the mouse button.

• Point to the boundary below row 
heading 14.

• Drag down until the ScreenTip 
indicates Height: 26.25 (35 pixels). 
Do not release the mouse button 
(Figure 2–59).

mouse pointer

row 3 height is 
60.00 points

current bottom 
border of row 14

ScreenTip shows 
proposed height 
of row 14

dotted line shows 
proposed bottom 
border of row 14

Figure 2–59

formatting of 
worksheet complete

row 14 height is 
26.25 points

Figure 2–60

added white space 
in row 14 improves 
appearance of 
worksheet

1. Right-click row heading 
or drag through multiple 
row headings and right-
click, click Row Height 

on shortcut menu, enter 
desired row height, click 
OK button

Other Ways

Q
&

A
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Checking Spelling
Excel has a spell checker you can use to check the worksheet for spelling errors. The 
spell checker looks for spelling errors by comparing words on the worksheet against words 
contained in its standard dictionary. If you often use specialized terms that are not in the 
standard dictionary, you may want to add them to a custom dictionary using the Spelling 
dialog box.

When the spell checker fi nds a word that is not in either dictionary, it displays the 
word in the Spelling dialog box. You then can correct it if it is misspelled.

To Check Spelling on the Worksheet

To illustrate how Excel responds to a misspelled word, the word, Stock, in cell A3 is misspelled purposely as 
the word, Stcok, as shown in Figure 2–61.

1
• Click cell A3 and 

then type Stcok to 
misspell the word 
Stock.

• Click cell A1.

• Click the Review 
tab on the Ribbon.

• Click the Spelling 
button on the 
Ribbon to run 
the spell checker 
and display the 
misspelled word, 
Stcok, in the 
Spelling dialog box 
(Figure 2–61).

What happens 
when the spell 
checker fi nds a 
misspelled word? 

When the spell 
checker identifi es 
that a cell contains 
a word not in its 
standard or custom 
dictionary, it selects 
that cell as the 
active cell and 
displays the Spell-
ing dialog box. The 
Spelling dialog box 
(Figure 2–61) lists 
the word not found in 
the dictionary and a list of suggested corrections.

Change button

Review tabSpelling button

misspelled word

AutoCorrect button

Ignore Once button

Spelling dialog box

indicates language to 
use in spell check

desired word in 
Suggestions list

Add to Dictionary 
button

Figure 2–61

Q
&

A

Ignore All and 
Change All 
buttons impact 
words throughout 
document

Hidden Rows 
You can use the keyboard 
to unhide a range of 
rows by selecting the 
rows immediately above 
and below the hidden 
rows and then pressing 
CTRL+SHIFT+( (LEFT 
PARENTHESIS). To use the 
keyboard to hide a range 
of rows, press CTRL+9.

B
T
W
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2
• With the word Stock highlighted 

in the Suggestions list, click the 
Change button to change
the misspelled word, Stcok, to the 
correct word, Stock and then 
select cell A18 (Figure 2–62).

• If the Microsoft Offi ce Excel 
dialog box is displayed, click the 
OK button.

3
• Click the Close button. 

• Click the Home tab on the Ribbon.

• Click the Save button on the 
Quick Access toolbar to save the 
workbook.

What other actions can I take in 
the Spelling dialog box? 

If one of the words in the 
Suggestions list is correct, click it 
and then click the Change but-
ton. If none of the suggestions is 
correct, type the correct word in 
the Not in Dictionary text box and 
then click the Change button. To 
change the word throughout the 
worksheet, click the Change All 
button instead of the Change but-
ton. To skip correcting the word, 
click the Ignore Once button. To 
have Excel ignore the word for 
the remainder of the worksheet, 
click the Ignore All button.

Save button

Stcok changed 
to Stock

Figure 2–62

Other Ways

1. Press F7

Q
&

A
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Additional Spell Checker Considerations
Consider these additional guidelines when using the spell checker:

• To check the spelling of the text in a single cell, double-click the cell to make the formula 
bar active and then click the Spelling button on the Review tab on the Ribbon.

• If you select a single cell so that the formula bar is not active and then start the 
spell checker, Excel checks the remainder of the worksheet, including notes and 
embedded charts.

• If you select a cell other than cell A1 before you start the spell checker, Excel will 
display a dialog box when the spell checker reaches the end of the worksheet, asking 
if you want to continue checking at the beginning.

• If you select a range of cells before starting the spell checker, Excel checks the 
spelling of the words only in the selected range.

• To check the spelling of all the sheets in a workbook, click Select All Sheets on the 
sheet tab shortcut menu and then start the spell checker. To instruct Excel to display 
the sheet tab shortcut menu, right-click any sheet tab.

• To add words to the dictionary such as your last name, click the Add to Dictionary 
button in the Spelling dialog box (Figure 2–61 on page EX 127) when Excel identifi es 
the word as not in the dictionary.

• Click the AutoCorrect button (Figure 2–61) to add the misspelled word and the correct 
version of the word to the AutoCorrect list. For example, suppose you misspell the 
word, do, as the word, dox. When the spell checker displays the Spelling dialog 
box with the correct word, do, in the Change to box, click the AutoCorrect button. 
Then, anytime in the future that you type the word, dox, Excel automatically will 
change it to the word, do.

Preparing to Print the Worksheet
Excel allows for a great deal of customization in how a worksheet appears when printed. 
For example, the margins on the page can be adjusted. A header or footer can be added to 
each printed page as well. Excel also has the capability to work on the worksheet in Page 
Layout View. Page Layout View allows you to create or modify a worksheet while viewing 
how it will look in printed format. The default view that you have worked in up until this 
point in the book is called Normal View.

Specify how the printed worksheet should appear.
Before printing a worksheet, you should consider how the worksheet will appear when 
printed. In order to fi t as much information on the printed page as possible, the margins of 
the worksheet should be set to a reasonably small width and height. The current Portfolio 
Summary worksheet will print on one page. If, however, the club added more data to the 
worksheet, then it may extend to multiple pages. It is, therefore, a good idea to add a page 
header to the worksheet that prints in the top margin of each page.

In Chapter 1, the worksheet was printed in portrait orientation, which means the printout 
is printed across the width of the page. Landscape orientation means the printout is printed 
across the length of the page. Landscape orientation is a good choice for the Silver Dollars 
Stock Club Portfolio Summary because the printed worksheet’s width is greater than its 
length. 

Plan
Ahead

Spell Checking 
While Excel’s spell 
checker is a valuable 
tool, it is not infallible. 
You should proofread 
your workbook carefully 
by pointing to each 
word and saying it 
aloud as you point to it. 
Be mindful of misused 
words such as its and it’s, 
through and though, 
and to and too. Nothing 
undermines a good 
impression more than 
a professional looking 
report with misspelled 
words.

B
T
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Error Checking 
Always take the time 
to check the formulas 
of a worksheet before 
submitting it to your 
supervisor. You can check 
formulas by clicking the 
Error Checking button on 
the Formulas tab on the 
Ribbon. You also should 
test the formulas by 
employing data that tests 
the limits of formulas. 
Experienced spreadsheet 
specialists spend as much 
time testing a workbook 
as they do creating it, 
before placing it into 
production.

B
T
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Certifi cation 
The Microsoft Certifi ed 
Application Specialist 
(MCAS) program provides 
an opportunity for you 
to obtain a valuable 
industry credential – 
proof that you have the 
Excel 2007 skills required 
by employers. For 
more information, see 
Appendix F or visit the 
Excel 2007 Certifi cation 
Web page (scsite.com/
ex2007/cert).

B
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1
• Click the Page 

Layout View button 
on the status bar to 
view the worksheet 
in Page Layout View 
(Figure 2–63).

What are some key 
features of Page 
Layout View? 

Page Layout View 
shows the worksheet 
divided into pages. 
A blue background 
separates each page. 
The white areas sur-
rounding each page 
indicate the print 
margins. The top of 
each page includes a 
Header area, and the 
bottom of each page 
includes a Footer 
area. Page Layout 
View also includes 
a ruler at the top 
of the page that 
assists you in placing 
objects on the page, such as charts and pictures.

To Change the Worksheet’s Margins, Header, and Orientation in Page Layout View

The following steps change to Page Layout View, narrow the margins of the worksheet, change the header of the 
worksheet, and set the orientation of the worksheet to landscape. 

Page Layout tab

Page Layout 
View button

Page Layout 
View shows how 
worksheet will look 
in printed format 

Figure 2–63

Q
&

A

2
• Click the Page 

Layout tab on the 
Ribbon.

• Click the Margins 
button on the 
Ribbon to display 
the Margins gallery 
(Figure 2–64).

Margins button

Margins gallery

worksheet margins 
set to Normal 
margin style

Figure 2–64

Narrow margin style
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3
• Click Narrow in the 

Margins gallery 
to change the 
worksheet margins 
to the Narrow 
margin style.

• Drag the scroll bar 
on the right side of 
the worksheet to 
the top so that row 1 
of the worksheet is 
displayed.

• Click above the 
worksheet title 
in cell A1 in the 
Header area.

• Type Treasurer: 
Juan Castillo  
and then press 
the ENTER key. 
Type castillo_
juan37@hotmail.

com to complete the 
worksheet header (Figure 2–65). 

Header area

new page header 
displays in Header area

worksheet margins set 
to Narrow margin style 
and column H now is 
displayed on fi rst page

Figure 2–65

4
• Select cell B16 to 

deselect the header. 
Click the Orientation 
button on the 
Ribbon to display 
the Orientation 
gallery.

• Point to Landscape 
but do not click 
the mouse button 
(Figure 2–66).

Orientation button

Landscape 
orientation

worksheet set to print 
in portrait orientation

Figure 2–66
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Previewing and Printing the Worksheet
In Chapter 1, the worksheet was printed without fi rst previewing it on the screen. By pre-
viewing the worksheet, however, you see exactly how it will look without generating a 
printout. Previewing a worksheet using the Print Preview command can save time, paper, 
and the frustration of waiting for a printout only to discover it is not what you want.

5
• Click Landscape in 

the Orientation 
gallery to change 
the worksheet’s 
orientation to 
landscape 
(Figure 2–67).

Do I need to change 
the orientation 
every time I want to 
print the 
worksheet? 

No. Once you change 
the orientation and 
save the workbook, 
Excel will save the 
orientation setting 
for that workbook 
until you change it. 
When you open a new workbook, Excel sets the orientation to portrait.

worksheet set to 
print in landscape 
orientation

Figure 2–67

Q
&

A

Other Ways

1. Click Page Layout tab 
on Ribbon, click Page 
Setup Dialog Box 
Launcher button, click 
appropriate tab, change 
desired options, click 
OK button

To Preview and Print a Worksheet

The following steps preview and then print the worksheet.

1
• Click the Offi ce Button and then 

point to Print on the Offi ce 
Button menu to display the Print 
submenu (Figure 2–68).

Print command

Print Preview 
command

Offi ce 
Button

Figure 2–68

C6161_EXC_02.4c.indd   132C6161_EXC_02.4c.indd   132 3/6/07   3:29:38 PM3/6/07   3:29:38 PM



Ex
ce

l 
C

h
ap

te
r 

2
Ex

ce
l 

C
h

ap
te

r 
2

Previewing and Printing the Worksheet   EX 133

2
• Click Print Preview  

on the Print sub-
menu to display 
a preview of the 
worksheet in land-
scape orientation 
(Figure 2–69). 

What is the purpose 
of the buttons in the 
Print Preview area? 

The Print button 
displays the Print 
dialog box and 
allows you to print 
the worksheet. The 
Page Setup button 
displays the Page 
Setup dialog box. 
The Zoom button al-
lows you to zoom in 
and out of the page 
displayed in the 
Preview window. 
You also can click the previewed page in the Preview window when the mouse pointer 
shape is a magnifying glass to carry out the function of the Zoom button.

Print button

Preview window

Figure 2–69

Q
&

A

3
• Click the Print 

button to display 
the Print dialog box 
(Figure 2–70).

How can I use the 
Print dialog box? 

When you click the 
Print command on 
the Print submenu 
of the Offi ce Button 
menu or a Print but-
ton in a dialog box 
or Preview window, 
Excel displays the 
Print dialog box 
shown in Figure 2–70. 
Excel does not display 
the Print dialog box 
when you use the 
Print button on the 
Quick Access toolbar, 
as was the case in 
Chapter 1. The Print 
dialog box allows 
you to select a 
printer, instruct Excel 
what to print, and indicate how many copies of the printout you want.

OK button

Print dialog box

Figure 2–70

Q
&

A
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4
• Click the OK 

button to print 
the worksheet 
(Figure 2–71).

worksheet printed in 
landscape orientation

Figure 2–71

Other Ways

1. Click Page Layout tab 
on Ribbon, click Page 
Setup Dialog Box 
Launcher button, click 
appropriate tab, change 
desired options, click 
OK button

To Print a Section of the Worksheet

You might not always want to print the entire worksheet. You can print portions of the worksheet by selecting 
the range of cells to print and then clicking the Selection option button in the Print what area in the Print dialog 
box. The following steps print the range A3:F16.

1
• Select the range A3:F16.

• Click the Offi ce Button and then 
click Print on the Offi ce Button 
menu to display the Print 
dialog box. 

• Click Selection in the Print 
what area to instruct Excel to 
print only the selected range 
(Figure 2–72).

OK button

Selection option 
button selected

range A3:F16 selected

Print dialog box

Figure 2–72
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Displaying and Printing the Formulas Version of the Worksheet   EX 135

2
• Click the OK button 

to print the selected 
range of the work-
sheet on the printer 
(Figure 2–73).

• Click the Normal 
View button on the 
status bar. 

• Click cell A18 to 
deselect the range 
A3:F13.

What are the 
options in the Print 
what area? 

The Print what area 
of the Print dialog 
box includes three 
option buttons 
(Figure 2–72). As 
shown in the previous 
steps, the Selection 
option button instructs 
Excel to print the 
selected range. The 
Active sheet(s) option 
button instructs Excel to print the active worksheet (the worksheet currently on the screen) or the selected worksheets. 
Finally, the Entire workbook option button instructs Excel to print all of the worksheets in the workbook.

header prints
selected 
range 
prints

Figure 2–73

Displaying and Printing the Formulas Version of 
the Worksheet
Thus far, you have been working with the values version of the worksheet, which shows 
the results of the formulas you have entered, rather than the actual formulas. Excel also 
can display and print the formulas version of the worksheet, which shows the actual 
formulas you have entered, rather than the resulting values. You can toggle between the 
values version and formulas version by holding down the CTRL key while pressing the 
ACCENT MARK (`) key, which is located to the left of the number 1 key on the keyboard.

The formulas version is useful for debugging a worksheet. Debugging is the process 
of fi nding and correcting errors in the worksheet. Viewing and printing the formulas 
version instead of the values version makes it easier to see any mistakes in the formulas.

When you change from the values version to the formulas version, Excel increases 
the width of the columns so the formulas and text do not overfl ow into adjacent cells on the 
right. The formulas version of the worksheet thus usually is signifi cantly wider than the 
values version. To fi t the wide printout on one page, you can use landscape orientation, 
which has already been selected for the workbook, and the Fit to option in the Page sheet 
in the Page Setup dialog box. 

Other Ways

1. Select range, click Page 
Layout tab on Ribbon, 
click Print Area button, 
click Quick Print button 
on Quick Access toolbar, 
click Print Area button, 
click Clear Print Area 
button

Q
&

A

Values versus 
Formulas
When completing class 
assignments, do not 
enter numbers in cells 
that require formulas. 
Most instructors require 
their students to hand in 
both the values version 
and formulas version 
of the worksheet. 
The formulas version 
verifi es that you entered 
formulas, rather than 
numbers, in formula-
based cells.

B
T
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To Display the Formulas in the Worksheet and Fit the Printout on One Page

The following steps change the view of the worksheet from the values version to the formulas version of the 
worksheet and then print the formulas version on one page.

1
• Press CTRL+ACCENT 

MARK (`).

• When Excel displays 
the formulas version 
of the worksheet, 
click the right 
horizontal scroll 
arrow until column J 
appears to display 
the worksheet with 
formulas 
(Figure 2–74).

Figure 2–74

numbers displayed 
using General format

formulas displayed 
as entered

2
• If necessary, click 

the Page Layout tab 
on the Ribbon and 
then click the Page Setup Dialog Box Launcher to display the Page Setup dialog box.

• If necessary, click Landscape to select it and then click Fit to in the Scaling area.

3
• Click the Print button in the Page Setup dialog box to print the formulas in the worksheet on 

one page in landscape orientation (Figure 2–75).

• When Excel displays the Print dialog box, click the OK button.

font size automatically 
reduced so worksheet 
fi ts on one page

Figure 2–75

formulas instead 
of values printed

4
• After viewing and printing the formulas version, press CTRL+ACCENT MARK (`) to instruct Excel to display the values version.

• Click the left horizontal scroll arrow until column A appears.

Other Ways

1. Click Show Formulas 
button on Formulas tab 
on Ribbon
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To Change the Print Scaling Option Back to 100%

Depending on your printer, you may have to change the Print Scaling option back 
to 100% after using the Fit to option. The following steps reset the Print Scaling option 
so future worksheets print at 100%, instead of being resized to print on one page.

1  If necessary, click the Page Layout tab on the Ribbon and then click the Page Setup Dialog 
Box Launcher to display the Page Setup dialog box.

2  Click Adjust to in the Scaling area.

3  If necessary, type 100 in the Adjust to box.

4  Click the OK button to set the print scaling to normal.

5  Click the Home tab on the Ribbon.

What is the purpose of the Adjust to box in the Page Setup dialog box? 

The Adjust to box allows you to specify the percentage of reduction or enlargement in the 
printout of a worksheet. The default percentage is 100%. When you click the Fit to option, this 
percentage automatically changes to the percentage required to fi t the printout on one page.

Importing External Data from a Web Source Using 
a Web Query
One of the major features of Excel is its capability of importing external data from Web 
sites. To import external data from a Web site, you must have access to the Internet. You 
then can import data stored on a Web site using a Web query. When you run a Web 
query, Excel imports the external data in the form of a worksheet. As described in Table 2–6, 
three Web queries are available when you fi rst install Excel. All three Web queries relate 
to investment and stock market activities.

Table 2–6 Excel Web Queries 

Query External Data Returned

MSN MoneyCentral Investor Currency Rates Currency rates 

MSN MoneyCentral Investor Major Indices Major indices 

MSN MoneyCentral Investor Stock Quotes Up to 20 stocks of your choice

Importing External Data from a Web Source Using a Web Query   EX 137

Gather information regarding the needed Web query.
As shown in Table 2–6, the MSN Money Central Investor Stock Quotes feature that is included 
with Excel allows you to retrieve information on up to 20 stocks of your choice. The Web 
query requires that you supply the stock symbols. The stock symbols are located in column B 
of the Portfolio Summary worksheet. 

Plan 
Ahead

Q
&

A

Web Queries 
Most Excel specialists that 
build Web queries use 
the worksheet returned 
from the Web query as 
an engine to supply data 
to another worksheet 
in the workbook. With 
3-D cell references, you 
can create a worksheet 
similar to the Silver 
Dollars Stock Club 
worksheet to feed the 
Web query stock symbols 
and get refreshed stock 
prices in return.

B
T
W
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To Import Data from a Web Source Using a Web Query

Although you can have a Web query return data to a blank workbook, the following steps have the data for 
the nine stock symbols in column B of the Portfolio Summary worksheet returned to a blank worksheet in the Silver 
Dollars Stock Club Portfolio Summary workbook. The data returned by the stock-related Web queries is real time 
in the sense that it is no more than 20 minutes old during the business day.

1

• With the Silver 
Dollars Stock Club 
Portfolio Summary 
workbook open, 
click the Sheet2 tab 
at the bottom of 
the window.

• With cell A1 active, 
click the Data tab 
on the Ribbon, 
and then click the 
Existing Connections 
button to display 
the Existing 
Connections dialog 
box (Figure 2–76).

Figure 2–76

Sheet2 tab 

Data tabExisting Connections 
button

MSN MoneyCentral 
Investor Stock 
Quotes connection

A1 is active cell

Existing Connections 
dialog box
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2

• Double-click MSN MoneyCentral 
Investor Stock Quotes to display 
the Import Data dialog box 
(Figure 2-77).

Importing External Data from a Web Source Using a Web Query   EX 139

OK button

instructs Excel to 
place upper-left 
corner of external 
data in cell A1

Figure 2–77

instructs Excel to 
place external data on 
current worksheet

Import Data 
dialog box

3
• Click the OK button.

• When Excel displays the Enter 
Parameter Value dialog box, type 
the nine stock symbols aapl t c 
cmcsa goog hd ibm mrk s in 
the text box.

• Click the ‘Use this value/reference 
for future refreshes’ check box to 
select it (Figure 2–78).

What is the purpose of clicking 
the check box? 

Once Excel displays the worksheet, 
you can refresh the data as often 
as you want. To refresh the data 
for all the stocks, click the Refresh 
All button on the Data tab on 
the Ribbon. Because the ‘Use 
this value/reference for future 
refreshes’ check box was selected, 
Excel will continue to use the same 
stock symbols each time it refreshes.

OK button

stock symbols 
separated by a space

Enter Parameter 
Value dialog box

keeps symbols 
entered above for 
future references

Figure 2–78

Q
&

A
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4

• Click the OK button 
to retrieve the stock 
quotes and display a 
new worksheet with 
the desired data 
(Figure 2–79).

What composes the 
new worksheet? 

As shown in 
Figure 2–79, Excel 
displays the data 
returned from the 
Web query in an 
organized, 
formatted 
worksheet, which 
has a worksheet 
title, column titles, 
and a row of data 
for each stock 
symbol entered. 
Other than the 
fi rst column, which 
contains the stock 
name and stock 
symbol, you have 
no control over the 
remaining columns 
of data returned. 
The latest price of 
each stock appears 
in column D.

Q
&

A

Other Ways

1. Press ALT+A, X, select 
data source

latest stock price

Refresh All button

Excel displays external 
data containing 
stock information in 
worksheet

Figure 2–79

links to MSN 
MoneyCentral 
Web site

Changing the Worksheet Names
The sheet tabs at the bottom of the window allow you to view any worksheet in the 
workbook. You click the sheet tab of the worksheet you want to view in the Excel window. 
By default, Excel presets the names of the worksheets to Sheet1, Sheet2, and so on. The 
worksheet names become increasingly important as you move towards more sophisticated 
workbooks, especially workbooks in which you reference cells between worksheets. 

Choose names for the worksheets.
Use simple, meaningful names for each worksheet. Name the fi rst worksheet that includes 
the portfolio summary Portfolio Summary. The second worksheet that includes the stock 
quotes should be named Real-Time Stock Quotes to refl ect its contents.

Plan
Ahead
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To Change the Worksheet Names

The following steps show how to rename worksheets by double-clicking the sheet tabs.

1
• Double-click the sheet tab labeled 

Sheet2 in the lower-left corner of 
the window.

• Type Real-Time Stock Quotes 
as the worksheet name and then 
press the ENTER key to display the 
new worksheet name on the sheet 
tab (Figure 2–80).

What is the maximum length for a 
worksheet tab? 

Worksheet names can be up to 
31 characters (including spaces) in 
length. Longer worksheet names, 
however, mean that fewer sheet 
tabs will show. To view more sheet 
tabs, you can drag the tab split 
box (Figure 2–81) to the right. This 
will reduce the size of the scroll 
bar at the bottom of the screen. 
Double-click the tab split box to 
reset it to its normal position.

Changing the Worksheet Names   EX 141
Q

&
A

Sheet2 name 
changed to Real-
Time Stock Quotes

Figure 2–80

2
• Double-click the sheet tab 

labeled Sheet1 in the lower-left 
corner of the window.

• Type Portfolio Summary as 
the worksheet name and then 
press the ENTER key to change 
the name of the worksheet from 
Sheet 1 to Portfolio Summary 
(Figure 2–81).

How can I quickly move between 
worksheet tabs? 

You can use the tab scrolling 
buttons to the left of the sheet 
tabs (Figure 2–81) to move 
between worksheets. The 
leftmost and rightmost scroll 
buttons move to the fi rst or last 
worksheet in the workbook. The 
two middle scroll buttons move 
one worksheet to the left or right.

tab split boxtab scrolling buttons
Sheet1 name changed 
to Portfolio Summary

Figure 2–81

Q
&

A

3
• Click the Home tab on the Ribbon.

C6161_EXC_02.4c.indd   141C6161_EXC_02.4c.indd   141 3/6/07   3:30:02 PM3/6/07   3:30:02 PM



EX 142   Excel Chapter 2   Formulas, Functions, Formatting, and Web Queries

E-Mailing a Workbook from within Excel
The most popular service on the Internet is electronic mail, or e-mail, which is the 
electronic transmission of messages and fi les to and from other computers using the 
Internet. Using e-mail, you can converse with friends across the room or on another con-
tinent. One of the features of e-mail is the capability to attach Offi ce fi les, such as Word 
documents or Excel workbooks, to an e-mail message and send it to a coworker. In the 
past, if you wanted to e-mail a workbook, you saved the workbook, closed the fi le, started 
your e-mail program, and then attached the workbook to the e-mail message before sending it. 
With Excel, you have the capability of e-mailing a worksheet or workbook directly from 
within Excel. For these steps to work properly, you must have an e-mail address and one 
of the following as your e-mail program: Microsoft Outlook, Microsoft Outlook Express, 
Microsoft Exchange Client, or another 32-bit e-mail program compatible with Messaging 
Application Programming Interface. 

To E-Mail a Workbook from within Excel

The following steps show how to e-mail the Silver Dollars Stock Club Portfolio Summary workbook from 
within Excel to Juan Castillo at the e-mail address castillo_juan37@hotmail.com.

1
• With the Silver 

Dollars Stock Club 
Portfolio Summary 
workbook open, 
click the Offi ce 
Button and then 
click Send to display 
the Send submenu 
(Figure 2–82).

Send command

E-mail command

Offi ce 
Button

Send submenu

Figure 2–82

Obtaining an E-Mail 
Account 
Several Web sites that 
allow you to sign up for 
free e-mail are available. 
Some choices are MSN 
Hotmail, Yahoo! Mail, 
and Google Gmail.

B
T
W

C6161_EXC_02.4c.indd   142C6161_EXC_02.4c.indd   142 3/6/07   3:30:04 PM3/6/07   3:30:04 PM



Ex
ce

l 
C

h
ap

te
r 

2
Ex

ce
l 

C
h

ap
te

r 
2

2
• Click E-mail on the 

Send submenu.

• When the 
e-mail Message 
window appears, 
type castillo_
juan37@hotmail.

com in the 
To text box.

• Type the message 
shown in the 
message area in 
Figure 2–83.

3
• Click the Send 

button to send 
the e-mail with 
the attached 
workbook to 
castillo_juan37@ 
hotmail.com.

How can the 
recipient use the 
attached workbook? 

Because the 
workbook was sent 
as an attachment, 
Juan Castillo can 
double-click the 
attachment in the e-mail to open it in Excel, or he can save it on disk and then open it later.

Chapter Summary   EX 143

Send button

To text box

workbook attached 
to e-mail

e-mail Message 
window

e-mail message 
in message area

e-mail address 
of person 
receiving e-mail

Figure 2–83

Q
&

A

To Save the Workbook and Quit Excel

With the workbook complete and e-mailed, the following steps save the workbook 
and quit Excel.

1  Click the Save button on the Quick Access toolbar.

2  Click the Close button on the upper-right corner of the title bar.

Chapter Summary
In creating the Silver Dollars Stock Club Portfolio Summary workbook, you learned how to enter formulas, calculate 
an average, fi nd the highest and lowest numbers in a range, verify formulas using Range Finder, draw borders, align 
text, format numbers, change column widths and row heights, and add conditional formatting to a range of num-
bers. In addition, you learned to spell check a worksheet, preview a worksheet, print a section of a worksheet, display 
and print the formulas version of the worksheet using the Fit to option, complete a Web query, rename sheet tabs, 

Quick Reference 
For a table that lists how 
to complete the tasks 
covered in this book 
using the mouse, Ribbon, 
shortcut menu, and 
keyboard, see the Quick 
Reference Summary at 
the back of this book, or 
visit the Excel 2007 Quick 
Reference Web page 
(scsite.com/ex2007/qr).

B
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and send an e-mail directly from within Excel with the opened workbook as an attachment. The items listed below 
include all the new Excel skills you have learned in this chapter.

 1. Enter a Formula Using the Keyboard (EX 91)
 2. Enter Formulas Using Point Mode (EX 93)
 3. Copy Formulas Using the Fill Handle (EX 95)
 4. Determine the Average of a Range of Numbers 

Using the Keyboard and Mouse (EX 99)
 5. Determine the Highest Number in a Range of 

Numbers Using the Insert Function Box (EX 101)
 6. Determine the Lowest Number in a Range of 

Numbers Using the Sum Menu (EX 102)
 7. Copy a Range of Cells across Columns to an 

Adjacent Range Using the Fill Handle (EX 104)
 8. Verify a Formula Using Range Finder (EX 106)
 9. Change the Workbook Theme (EX 109)
 10. Change the Background Color and Apply a Box 

Border to the Worksheet Title and Subtitle 
(EX 110)

 11. Center Data in Cells and Format Dates (EX 113)
 12. Apply an Accounting Number Format and Comma 

Style Format Using the Ribbon (EX 115)

 13. Apply a Currency Style Format with a Floating 
Dollar Sign Using the Format Cells Dialog Box 
(EX 116)

 14. Apply a Percent Style Format and Use the Increase 
Decimal Button (EX 118)

 15. Apply Conditional Formatting (EX 119)
 16. Change the Widths of Columns (EX 122)
 17. Change the Heights of Rows (EX 125)
 18. Check Spelling on the Worksheet (EX 127)
 19. Change the Worksheet’s Margins, Header, and 

Orientation in Page Layout View (EX 130)
 20. Preview and Print a Worksheet (EX 132)
 21. Print a Section of the Worksheet (EX 134)
 22. Display the Formulas in the Worksheet and Fit the 

Printout on One Page (EX 136)
 23. Import Data from a Web Source Using a Web 

Query (EX 138)
 24. Change the Worksheet Names (EX 141)
 25. E-Mail a Workbook from within Excel (EX 142)

Learn It Online

Learn It Online is a series of online student exercises that test your knowledge of chapter 
content and key terms.

Instructions: To complete the Learn It Online exercises, start your browser, click the Address bar, and 
then enter the Web address scsite.com/ex2007/learn. When the Excel 2007 Learn It Online 
page is displayed, click the link for the exercise you want to complete and then read the instructions.

Chapter Reinforcement TF, MC, and SA
A series of true/false, multiple choice, and short 
answer questions that test your knowledge of the 
chapter content. 

Flash Cards
An interactive learning environment where 
you identify chapter key terms associated with 
displayed defi nitions. 

Practice Test
A series of multiple choice questions that test 
your knowledge of chapter content and key terms. 

Who Wants To Be a Computer Genius?
An interactive game that challenges your 
knowledge of chapter content in the style of a 
television quiz show.

Wheel of Terms
An interactive game that challenges your 
knowledge of chapter key terms in the style of the 
television show Wheel of Fortune.

Crossword Puzzle Challenge
A crossword puzzle that challenges your 
knowledge of key terms presented in the chapter. 

If you have a SAM user profi le, you may have access to hands-on instruction, practice, and 
assessment. Log in to your SAM account (http://sam2007.course.com) to launch any assigned 
training activities or exams that relate to the skills covered in this chapter.
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Apply Your Knowledge   EX 145

Apply Your knowledge

Reinforce the skills and apply the concepts you learned in this chapter.

Profi t Analysis Worksheet
Instructions Part 1: Start Excel. Open the workbook Apply 2-1 Car-B-Clean Profi t Analysis. See 
the inside back cover of this book for instructions for downloading the Data Files for Students or see 
your instructor for information on accessing the fi les required in this book. The purpose of this exercise 
is to open a partially completed workbook, enter formulas and functions, copy the formulas and 
functions, and then format the worksheet titles and numbers. As shown in Figure 2–84, the completed 
worksheet analyzes profi ts by product. 

Continued >

Perform the following tasks.
 1. Use the following formulas in cells E4, F4, and G4:

  Total Sales (cell E4) = Units Sold * (Unit Cost + Unit Profi t) or =D4 * (B4 + C4)

  Total Profi t (cell F4) = Units Sold * Unit Profi t or = D4 * C4

  % Total Profi t (cell G4) = Total Profi t / Total Sales or = F4 / E4

  Use the fi ll handle to copy the three formulas in the range E4:G4 to the range E5:G12. 

 2. Determine totals for the units sold, total sales, and total profi t in row 13. Copy cell G12 to G13 to 
assign the formula in cell G12 to G13 in the total line. 

Figure 2–84
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Apply Your Knowledge continued

 3. In the range B14:B16, determine the lowest value, highest value, and average value, respectively, 
for the values in the range B4:B12. Use the fi ll handle to copy the three functions to the range 
C14:G16. Delete the average from cell G16, because an average of percentages of this type is 
mathematically invalid.

 4. Format the worksheet as follows:

  a.   change the workbook theme to Concourse by using the Themes button on the Page Layout tab 
on the Ribbon

  b.   cell A1 — change to font size 24 with a green (column 6 of standard colors) background and 
white font color by using the buttons in the Font group on the Home tab on the Ribbon

  c.   cell A2 — change to a green (column 6 of standard colors) background and white font color

  d.   cells B4:C4, E4:F4, and E13:F13 — Accounting style format with two decimal places and fi xed 
dollar signs (use the Accounting Style button on the Home tab on the Ribbon)

  e.   cells B5:C12 and E5:F12 — Comma style format with two decimal places (use the Comma Style 
button on the Home tab on the Ribbon)

  f.   cells D4:D16 — Comma style format with no decimal places

  g.   cells G4:G15 — Percent style format with three decimal places

  h.   cells B14:C16 and E14:F16 — Currency style format with fl oating dollar signs (use the Format 
Cells: Number Dialog Box Launcher on the Home tab on the Ribbon)

 5. Switch to Page Layout view and enter your name, course, laboratory assignment number 
(Apply 2-1), date, and any other information requested by your instructor in the Header area. 
Preview and print the worksheet in landscape orientation. Change the document properties, as 
specifi ed by your instructor. Save the workbook using the fi le name, Apply 2-1 Car-B-Clean Profi t 
Analysis Complete in the format specifi ed by your instructor.

 6. Use Range Finder to verify the formula in cell F4. 

 7. Print the range A3:E16. Press CTRL+ACCENT MARK ( `) to change the display from the values 
version of the worksheet to the formulas version. Print the formulas version in landscape 
orientation on one page (Figure 2–85) by using the Fit to option in the Page sheet in the Page 
Setup dialog box. Press CTRL+ACCENT MARK ( `) to change the display of the worksheet back to 
the values version. Do not save the workbook. If requested, submit the three printouts to your 
instructor.

Instructions Part 2: 
 1. In column C, use the keyboard to add manually $1.00 to the profi t of each product with a unit 

profi t less than $7.00 and $3.00 to the profi ts of all other products. You should end up with 
$2,765,603.80 in cell F13. 

 2. Print the worksheet. Do not save the workbook. If requested, submit the revised workbook in the 
format specifi ed by your instructor.
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Figure 2–85

 2. With range C4:C18 selected, apply a 
conditional format to the range that highlights 
scores that are below average.

 3. With range D4:D18 selected, apply a 
conditional format to the range that highlights 
any grade that is a D or an F.

 4. With range B4:B18 selected, apply a 
conditional format to the range that uses a red 
color to highlight any duplicate student names.

 5. Change the document properties, as specifi ed 
by your instructor. Change the worksheet 
header with your name, course number, 
and other information requested by your 
instructor. Save the workbook using the fi le 
name, Extend 2-1 Biology 201 Midterm 
Scores Complete, and submit the revised 
workbook as specifi ed by your instructor.

Extend Your Knowledge

Extend the skills you learned in this chapter and experiment with new skills. You may need to 
use Help to complete the assignment.

Applying Conditional Formatting to Cells
Instructions: Start Excel. Open the workbook Extend 2-1 Biology 201 Midterm Scores. See the inside back 
cover of this book for instructions for downloading the Data Files for Students, or see your instructor 
for information on accessing the fi les required in this book. Perform the following tasks to apply new 
conditional formatting to the worksheet.
 1. Select the range C4:C18. Click the Conditional Formatting button on the Home tab on the 

Ribbon and then select New Rule in the Conditional Formatting gallery. Select 'Format only top 
or bottom ranked values' in the Select a Rule Type area (Figure 2–86). Enter a value between 20 
and 35 of your choosing in the text box in the Edit the Rule Description area and click the ‘% of 
selected range’ check box to select it. Click the Format button and choose a format to assign to this 
conditional format. Click the OK button in each dialog box to close the dialog boxes and view the 
worksheet.

Figure 2–86

Extend Your Knowledge    EX 147
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Make It Right

Analyze a workbook and correct all errors and/or improve the design.

Correcting Functions and Formulas in a Worksheet
Instructions: Start Excel. Open the workbook Make It Right 2-1 El Centro Diner Payroll Report. 
See the inside back cover of this book for instructions for downloading the Data Files for Students, or 
see your instructor for information on accessing the fi les required for this book. Correct the following 
formatting, function, and formula problems (Figure 2–87) in the worksheet.

Figure 2–87

 1. Adjust the width of column B to 11.25 pixels so that the word in the column header does not wrap.

 2. Spell check the worksheet and correct any spelling mistakes that are found, but ignore any spelling 
mistakes found with the worksheet title and the employee names.

 3. The averages in several columns do not include the employee in row 13. Adjust the functions in 
these cells so that all employees are included in the calculation.

 4. The net pay calculation should be:

 Net Pay = Gross Pay – (Federal Taxes + State Taxes)

  Adjust the formulas in the range H4:H13 so that the correct formula is used.

 5. The value for the highest value in column C was entered as a number rather than as a function. 
Replace the value with the appropriate function.

 6. The currency values in row 4 should be formatted with the Accounting Number Format button on 
the Home tab on the Ribbon. They are currently formatted with the Currency format. 

 7. Delete the function in the cell containing the average of % Taxes because it is mathematically 
invalid.
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In the Lab   EX 149

 8. Change the document properties, as specifi ed by your instructor. Change the worksheet header 
with your name, course number, and other information requested by your instructor. Save the 
workbook using the fi le name, Make It Right 2-1 El Centro Diner Payroll Report Corrected. 
Submit the revised workbook as specifi ed by your instructor.

Table 2–8 Facade Importers Sales Data 

Sales Representative Sales Amount Sales Return Sales Quota

Polizzi, Bernard 591518 12638 765130

Li, Grace 895050 12015 776381

Volpe, Pamela 716502 18141 733309

Khan, Anwer 709672 22326 566940

Hudson, Emma 802525 11138 712222

Huerta, Teresa 885156 18721 778060

Figure 2–88

In the Lab

Create a workbook using the guidelines, concepts, and skills presented in this chapter. Labs 
are listed in order of increasing diffi culty.

Lab 1: Sales Analysis Worksheet
Problem: You have been asked to build a sales analysis worksheet for Facade Importers that determines 
the sales quota and percentage of quota met for the sales representatives in Table 2–8. The desired 
worksheet is shown in Figure 2–88.

Continued >
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In the Lab continued

Instructions Part 1: Perform the following tasks to build the worksheet shown in Figure 2–88.
 1. Apply the Aspect theme to the worksheet by using the Themes button on the Page Layout tab on the 

Ribbon.

 2. Increase the width of column A to 19.00 points and the width of columns B through F to 13.50 points.

 3. Enter the worksheet title Facade Importers in cell A1 and the worksheet subtitle Sales 
Analysis in cell A2. Enter the column titles in row 3 as shown in Figure 2–88. In row 3, use 
ALT+ENTER to start a new line in a cell.

 4. Enter the sales data described in Table 2–8 in columns A, B, C, and E in rows 4 through 9. Enter 
the row titles in the range A10:A14 as shown in Figure 2–88 on the previous page.

 5. Obtain the net sales in column D by subtracting the sales returns in column C from the sales 
amount in column B. Enter the formula in cell D4 and copy it to the range D5:D9.

 6. Obtain the above quota amounts in column F by subtracting the sales quota in column E from the 
net sales in column D. Enter the formula in cell F4 and copy it to the range F5:F9.

 7. Obtain the totals in row 10 by adding the column values for each salesperson. In the range B11:B13, 
use the AVERAGE, MAX, and MIN functions to determine the average, highest value, and lowest 
value in the range B4:B9. Copy the range B11:B13 to the range C11:F13.

 8. Determine the percent of quota sold in cell B14 by dividing the total net sales amount in cell D10 
by the total sales quota amount in cell E10. Center this value in the cell.

 9. If necessary, click the Home tab on the Ribbon. One at a time, merge and center the worksheet 
title and subtitle across columns A through F. Select cells A1 and A2 and change the background 
color to red (column 2 in the Standard Colors area on the Fill Color palette). Apply the Title cell 
style to cells A1 and B1 by clicking the Cell Styles button on the Home tab on the Ribbon and 
clicking the Title cell style in the Titles and Headings area in the Cell Styles gallery. Change the 
worksheet title in cell A1 to 28-point white (column 1, row 1 on the Font Color gallery). Change 
the worksheet subtitle to the same color. Assign a thick box border from the Borders gallery to the 
range A1:A2.

 10. Center the titles in row 3, columns A through F. Apply the Heading 3 cell style to the range A3:F3. 
Use the Italic button on the Home tab on the Ribbon to italicize the column titles in row 3 and the 
row titles in the range A10:A14. 

 11. Apply the Total cell style to the range A10:F10. Assign a thick box to cell B14. Change the 
background and font colors for cell B14 to the same colors applied to the worksheet title in Step 9.

 12. Change the row heights of row 3 to 33.00 points and rows  11 and 14 to 30.00 points.

 13. Select cell B14 and then click the Percent Style button on the Home tab on the Ribbon. Click the 
Increase Decimal button on the Ribbon twice to display the percent in cell B14 to hundredths.

 14. Use the CTRL key to select the ranges B4:F4 and B10:F13. That is, select the range B4:F4 and 
then while holding down the CTRL key, select the range B10:F13. Use the Format Cells: Number 
Dialog Box Launcher button on the Home tab on the Ribbon to display the Format Cells dialog 
box to assign the selected ranges a Floating Dollar Sign style format with two decimal places and 
parentheses to represent negative numbers. Select the range B5:F9 and click the Comma Style 
button on the Home tab on the Ribbon.

 15. Rename the sheet tab as Sales Analysis. Change the document properties, as specifi ed by your 
instructor. Change the worksheet header with your name, course number, and other information 
requested by your instructor.
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 16. Save the workbook using the fi le name Lab 2-1 Part 1 Facade Importers Sales Analysis. Print the 
entire worksheet in landscape orientation. Print only the range A3:B10.

 17. Display the formulas version by pressing CTRL+ACCENT MARK ( `). Print the formulas version using 
the Fit to option button in the Scaling area on the Page tab in the Page Setup dialog box. After 
printing the worksheet, reset the Scaling option by selecting the Adjust to option button on the 
Page tab in the Page Setup dialog box and changing the percent value to 100%. Change the display 
from the formulas version to the values version by pressing CTRL+ACCENT MARK ( `). Do not save 
the workbook.

 18. Submit the assignment as specifi ed by your instructor.

Instructions Part 2: With the workbook created in Part 1, manually decrement each of the six values 
in the net sales column by $10,000.00 until the percent of quota sold in cell B14 is below, yet as close 
as possible to, 100%. All six values in column E must be incremented the same number of times. 
The percent of quota sold in B14 should equal 99.85%. Update the worksheet header and save 
the workbook as Lab 2-1 Part 2 Facade Importers Sales Analysis. Print the worksheet. Submit the 
assignment as specifi ed by your instructor.

Instructions Part 3: With the percent of quota sold in cell B14 equal to 99.85% from Part 2, manually 
decrement each of the six values in the sales return column by $1,000.00 until the percent of quota 
sold in cell B14 is above, yet as close as possible to, 100%. Decrement all six values in column C the 
same number of times. Your worksheet is correct when the percent of quota sold in cell B14 is equal 
to 100.12%. Update the worksheet header and save the workbook as Lab 2-1 Part 3 Facade Importers 
Sales Analysis. Print the worksheet. Submit the assignment as specifi ed by your instructor.

In the Lab

Lab 2: Balance Due Worksheet
Problem: You are a spreadsheet intern for Jackson’s Bright Ideas, a popular Denver-based light fi xture 
store with outlets in major cities across the western United States. You have been asked to use Excel to 
generate a report (Figure 2–89) that summarizes the monthly balance due. A graphic breakdown of the 
data also is desired. The customer data in Table 2–9 is available for test purposes.

Table 2–9 Jackson’s Bright Ideas Monthly Balance Due Data 

Customer Beginning Balance Credits Payments Purchases

Costa, Dan 160.68 18.70 99.33 68.28

Hernandez, Abraham 138.11 48.47 75.81 46.72

Mc Cartan, John 820.15 32.11 31.23 29.19

Paoli, Pam 167.35 59.32 52.91 33.90

Ramirez, Alberto 568.34 55.17 18.53 36.34

Vaughn, Noah 449.92 25.90 82.05 99.77

Xiong, James 390.73 48.12 19.35 92.13
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In the Lab continued

Perform the following tasks:
 1. Enter and format the worksheet title Jackson's Bright Ideas and worksheet subtitle 

Monthly Balance Due Report in cells A1 and A2. Change the theme of the worksheet to 
the Technic theme. Apply the Title cell style to cells A1 and A2. Change the font size in cell A1 
to 28 points. One at a time, merge and center the worksheet title and subtitle across columns A 
through G. Change the background color of cells A1 and A2 to yellow (column 4 in the Standard 
Colors area in the Font Color palette). Draw a thick box border around the range A1:A2.

 2. Change the width of column A to 20.00 characters. Change the widths of columns B through G to 
12.00. Change the heights of row 3 to 36.00 and row 12 to 30.00 points.

 3. Enter the column titles in row 3 and row titles in the range A11:A14 as shown in Figure 2–89. 
Center the column titles in the range A3:G3. Apply the Heading 3 cell style to the range A3:G3. 
Bold the titles in the range A11:A14. Apply the Total cell style to the range A11:G11. Change the 
font size of the cells in the range A3:G14 to 12 points.

 4. Enter the data in Table 2–9 in the range A4:E10.

 5. Use the following formulas to determine the service charge in column F and the new balance in 
column G for the fi rst customer. Copy the two formulas down through the remaining customers.

  a.   Service Charge (cell F4) = 2.75% * (Beginning Balance – Payments – Credits) 
or = 0.0275 * (B4 – C4 – D4)

  b.   New Balance (G4) = Beginning Balance + Purchases – Credits – Payments + Service Charge 
or =B4 + E4 – C4 – D4 + F4

 6. Determine the totals in row 11.    

Figure 2–89

Instructions Part 1: Create a worksheet similar to the one shown in Figure 2–89. Include the fi ve columns 
of customer data in Table 2–9 in the report, plus two additional columns to compute a service charge 
and a new balance for each customer. Assume no negative unpaid monthly balances. 

C6161_EXC_02.4c.indd   152C6161_EXC_02.4c.indd   152 3/6/07   3:30:19 PM3/6/07   3:30:19 PM



Ex
ce

l 
C

h
ap

te
r 

2
S

T
U

D
E

N
T
  

A
S

S
IG

N
M

E
N

T
S

In the Lab   EX 153

Continued >

 7. Determine the maximum, minimum, and average values in cells B12:B14 for the range B4:B10 and 
then copy the range B12:B14 to C12:G14.

 8. Use the Format Cells command on the shortcut menu to format the numbers as follows: (a) assign the 
Currency style with a fl oating dollar sign to the cells containing numeric data in the ranges B4:G4 and 
B11:G14; and (b) assign the Comma style (currency with no dollar sign) to the range B5:G10.

 9. Use conditional formatting to change the formatting to white bold font on a red background in any 
cell in the range C4:C10 that contains a value greater than 50.

 10. Change the worksheet name from Sheet1 to Balance Due. Change the document properties, as 
specifi ed by your instructor. Change the worksheet header with your name, course number, and 
other information requested by your instructor.

 11. Spell check the worksheet. Preview and then print the worksheet in landscape orientation. Save the 
workbook using the fi le name, Lab 2-2 Part 1 Jackson’s Bright Ideas Monthly Balance Due Report.

 12. Print the range A3:D14. Print the formulas version on one page. Close the workbook without 
saving the changes. Submit the assignment as specifi ed by your instructor.

Instructions Part 2: This part requires that a 3-D Bar chart with a cylindrical shape be inserted on a 
new worksheet in the workbook. If necessary, use Excel Help to obtain information on inserting a chart 
on a separate sheet in the workbook.
 1. With the Lab 2-2 Part 1 Jackson’s Bright Ideas Monthly Balance Due Report workbook open, draw 

the 3-D Bar chart with cylindrical shape showing each customer’s total new balance as shown in 
Figure 2–90. 

Figure 2–90

 2. Use the CTRL key and mouse to select the nonadjacent chart ranges A4:A10 and G4:G10. That is, 
select the range A4:A10 and then while holding down the CTRL key, select the range G4:G10. The 
customer names in the range A4:A10 will identify the cylindrical bars, while the data series in the 
range G4:G10 will determine the length of the bars. 
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In the Lab continued

 3. Click the Insert tab on the Ribbon. Click the Bar button in the Charts group on the Ribbon and 
then select Clustered Horizontal Cylinder in the Cylinder area. When the chart is displayed on the 
worksheet, click the Move Chart button on the Ribbon. When the Move Chart dialog box appears, 
click New sheet and then type Bar Chart for the sheet name. Click the OK button.

 4. When the chart is displayed on the new worksheet, click the wall behind the bars and then click 
the Format contextual tab. Click the Shape Fill button on the Ribbon and then select Gold, 
Accent 2, Lighter 80% in the gallery (column 6, row 2). Click the Layout contextual tab. Click 
the Chart Title button on the Ribbon and then select Above Chart in the Chart Title gallery. If 
necessary, use the scroll bar on the right side of the worksheet to scroll to the top of the chart. 
Click the chart title to select it and then type Balance Due as the chart title.

 5. Drag the Balance Due tab at the bottom of the worksheet to the left of the Bar Chart tab to 
reorder the sheets in the workbook. Preview and print the chart. 

 6. Click the Balance Due sheet tab. Change the following purchases: customer John Mc Cartan to 
$406.58, and customer Pam Paoli to $74.99. The company also decided to change the service 
charge from 2.75% to 3.25% for all customers. After copying the adjusted formula in cell F4 to 
the range F5:F10, click the Auto Fill Options button and then click Fill without Formatting to 
maintain the original formatting in the range F5:F10. The total new balance in cell G11 should 
equal $2,919.01. 

 7. Select both sheets by holding down the SHIFT key and then clicking the Bar Chart tab. Preview 
and print the selected sheets. Submit the assignment as requested by your instructor. Save the 
worksheet using the fi le name, Lab 2-2 Part 2 Jackson’s Bright Ideas Monthly Balance Due Report.

 8. Submit the assignment as specifi ed by your instructor.

Instructions Part 3: With your instructor’s permission, e-mail the workbook created in this exercise 
with the changes indicated in Part 2 as an attachment to your instructor. Close the workbook without 
saving the changes.

In the Lab

Lab 3: Equity Web Queries
Problem: A friend of your family, Benson Yackley, has 
learned that Excel can connect to the Web, download 
real-time stock data into a worksheet, and then refresh 
the data as often as needed. Because you have had 
courses in Excel and the Internet, he has hired you as 
a consultant to develop a stock analysis workbook. His 
portfolio is shown in Table 2–10. 

Instructions Part 1: Start Excel. If necessary, connect to 
the Internet. Perform a Web query to obtain multiple 
stock quotes (Figure 2–91), using the stock symbols in 
the second column of Table 2–10. Place the results of the 
Web query in a new worksheet. Rename the worksheet 
Real-Time Stock Quotes. Change the document properties, as specifi ed by your instructor. Add a header 
with your name, course number, and other information requested by your instructor. Save the workbook 
using the fi le name, Lab 2-3 Part 1 Benson Yackley Equities Online. Preview and then print the 
worksheet in landscape orientation using the Fit to option.

Table 2–10 Benson Yackley’s Stock Portfolio

Company Stock Symbol

Exxon Mobil XOM

Dell DELL

Hewlett-Packard HPQ

Intel INTC

MetLife MET

PepsiCo PEP

C6161_EXC_02.4c.indd   154C6161_EXC_02.4c.indd   154 3/6/07   3:30:24 PM3/6/07   3:30:24 PM



Ex
ce

l 
C

h
ap

te
r 

2
S

T
U

D
E

N
T
  

A
S

S
IG

N
M

E
N

T
S

In the Lab   EX 155

Click the following links and print the Web page that appears in the browser window: Click 
here to visit MSN Money; Dell Inc.; Chart (to the right of MetLife, Inc.); and News (to the right of 
PepsiCo, Inc.). Submit the assignment as specifi ed by your instructor.

Figure 2–91

Instructions Part 2: While connected to the Internet and with the Lab 2-3 Benson Yackley Equities 
Online workbook open, create a worksheet listing the major indices and their current values on Sheet2 
of the workbook (Figure 2–92). After clicking the Sheet2 tab, create the worksheet by double-clicking 
MSN MoneyCentral Investor Major Indices in the Select Data Source dialog box. The dialog box is 
displayed when you click the Existing Connections button on the Data tab on the Ribbon. Rename 
the worksheet Major Indices. Preview and then print the Major Indices worksheet in landscape 
orientation using the Fit to option. Save the workbook using the same fi le name as in Part 1. Submit 
the assignment as specifi ed by your instructor.

Figure 2–92
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Cases and Places

Apply your creative thinking and problem solving skills to design and implement a solution. 

•  EASIER  ••MORE DIFFICULT 

• 1: Design and Create a Weight-Loss Plan Worksheet
As a summer intern working for Choose to Lose, a local weight-loss clinic, you have been asked to 
create a worksheet that estimates the monthly weight lost for an individual based on recommended 
average daily activities. You have been given the numbers of calories burned per hour and the average 
number of hours for each activity (Table 2–11). Use the following formulas:
  Formula A: Total Calories Burned per Day = Calories burned per Hour � Average Hours Daily

  Formula B: Total Pounds Lost per Month (30 days) = 30 � Total Calories Burned per Day � 3500

  Formula C: Average function

  Formula D: Max function

  Formula E: Min function
Use the concepts and techniques presented in this project to create and format the worksheet. Include an 
embedded 3-D Pie chart that shows the contribution of each activity to the total calories burned per day. 
Use Microsoft Excel Help to create a professional looking 3-D Pie chart with title and data labels.

Table 2–11 Activities with Corresponding Calories Burned per Hour and Worksheet Layout 

Activity
Calories 
Burned 
per Hour

Average 
Hours 
Daily

Total Calories 
Burned per 
Day

Total Pounds  
Lost per Month 
(30 Days)

Aerobics class 450 0.50 Formula A Formula B

Brisk walking 350 0.50

House work 150 1.00

Offi ce work/sitting 120 6.00

Sleeping 70 9.00

Standing 105 2.00

Swimming 290 0.50

Tennis 315 0.25

Walking 240 4.25

Totals — — — 

Average Formula C  

Highest Formula D

Lowest Formula E
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Continued >

Table 2–12 Doze-Now Profi t Potential Data and Worksheet Layout 

Item Units on 
Hand

Average 
Unit Cost

Total 
Cost

Average 
Unit Price

Total 
Value

Potential 
Profi t

Comforters 216 46.52 Formula A Formula B Formula C Formula D

Night lights 4,283 6.89

Pillows 691 47.64

Sleep sound machines 103 45.06

Sleepwear 489 16.77

Total — — — — —

Average Formula E

Lowest Formula F

Highest Formula G

Table 2–13 Doze-Now Profi t Potential Formulas 

Formula A = Units on Hand * Average Unit Cost

Formula B = Average Unit Cost * (1 / (1 – .58))

Formula C = Units on Hand * Average Unit Price

Formula D = Total Value – Total Cost

Formula E = AVERAGE function

Formula F = MIN function

Formula G = MAX function

• 2: Create a Profi t Potential Worksheet
You work part-time for Doze-Now, a retailer of sleep-related products. Your manager wants to know 
the profi t potential of their inventory based on the categories of inventory in Table 2–12. Table 2–12 
contains the format of the desired report. The required formulas are shown in Table 2–13. Use the 
concepts and techniques developed in this project to create and format the worksheet. Submit a 
printout of the values version and formulas version of the worksheet. The company just received a 
shipment of 175 additional comforters and 273 items of sleepwear. Update the appropriate cells in the 
Units on Hand column. 
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Cases and Places  continued

Table 2–15 Band Fund-Raising Formulas 

Formula A = Cost per Unit / (1 – Margin) 

Formula B = 2000 * (Selling Price – Cost per Unit)

Formula C = 5000 *110% * (Selling Price – Cost per Unit)

Formula D = MIN function

Formula E = MAX function

•• 3: Create a Fund-Raising Analysis Worksheet
You are the chairperson of the fund-raising committee for a local charity. You want to compare 
various fund-raising ideas to determine which will give you the best profi t. The data obtained from 
six businesses about their products and the format of the desired report are shown in Table 2–14. The 
required formulas are shown in Table 2–15. Use the concepts and techniques presented in this project 
to create and format the worksheet.

Table 2–14 Fund-Raising Data and Worksheet Layout 

Product Company
Cost 

per Unit Margin Selling Price
Profi t per 
2000 Sales

Profi t per 
5000 Sales

Candles Woodland Farms $4.75 40% Formula A Formula B Formula C

Candy Polkandy 3.00 70%  

Coffee Garcia Coffee 6.50 45%

Cookie dough Oh, Dough! 2.90 65%

Flower bulbs Early Bloom 2.40 50%

T-shirts Zed’s Sports 5.75 42% 

Minimum Formula D

Maximum Formula E

•• 4: Design and Create a Projected Budget

Make It Personal 
For the next six-month period, forecast your income for each month, your base expenditures for each 
month, and your special expenditures for each month. Base expenditures include expenses that occur 
each month, such as food and loan payments. Special expenditures include expenses that are out of the 
ordinary, such as the purchase of gifts, automobile insurance, and medical expenses. With this data, 
develop a worksheet calculating the amount of remaining money at the end of each month. You can 
determine this amount by subtracting both expenses from the anticipated income. 

Include a total, average value, highest value, and lowest value for income, base expenditures, 
special expenditures, and remaining money. Use the concepts and techniques presented in this project 
to create and format the worksheet.

Create a 3-D Pie chart on a separate sheet illustrating the portion each month’s special expenditures 
deducts from the total remaining money after all six months have passed. Use Microsoft Excel Help to 
create a professional looking 3-D Pie chart with title and data labels.
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•• 5: Design and Create a Stock Analysis Worksheet

Working Together 
Have each member of your team select six stocks — two bank stocks, two communications stocks, and 
two Internet stocks. Each member should submit the stock names, stock symbols, and an approximate 
six-month-old price. Create a worksheet that lists the stock names, symbols, price, and number of 
shares for each stock (use 350 shares as the number of shares for all stocks). Format the worksheet so 
that it has a professional appearance and is as informative as possible.

Have the group do research on the use of 3-D references, which is a reference to a range that 
spans two or more worksheets in a workbook (use Microsoft Excel Help). Use what the group learns to 
create a Web query on the Sheet2 worksheet by referencing the stock symbols on the Sheet1 work-
sheet. On the Sheet1 worksheet, change the cells that list current price per share numbers on the 
Sheet1 worksheet so that they use 3-D cell references that refer to the worksheet created by the Web 
query on the Sheet2 worksheet. Present your workbook and fi ndings to the class.
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